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POVZETEK 
 
V zadnjih desetletjih je opaziti veliko razpršene novogradnje, ki upoštevajo drugačne 
okoljske dejavnike kot starejša naselja in segajo na manj primerna območja za 
pozidavo. Z uporabo geografskih informacijskih sistemov (GIS) so bile ugotovljene 
prostorske danosti na testnem območju v Prekmurju. Uporabljeni so bili rastrski 
podatkovni sloj digitalnega modela reliefa (DMR) in vektorski podatkovni sloji rabe tal, 
poplavnega območja in javne gospodarske infrastrukture (GJI). Izdelana sta bila 
induktivni in deduktivni model, ki se razlikujeta v pristopu analize. Ugotovljene so bile 
prostorske danosti, ki jih upoštevajo naselja v letu 1850 in v kolikšni meri te dejavnike 
upoštevajo novogradnje iz obdobij 1850–1890, 1890–1940, 1940–1971 in 1971–2009. 
Naloga obravnava tudi spremembe pokrajine od leta 1850 do leta 2009. Poleg tega so 
bila razvita orodja za izračun kapa-testa neodvisnosti, orodje za izračun prekrivanja 
slojev in orodje za iskanje območij, ki so služila pri izvedbi analiz. Rezultati analiz so 
pokazali spremembe leg naselij in rabe tal tekom obravnavanih obdobij. Pri tem so bili 
upoštevani naklon, ukrivljenost in ekspozicija površja, poplavno območje, vlažnost tal in 
vetrovnost. 
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ABSTRACT 
 
Over the past few decades, a lot of scattered settlement patterns have been noticed 
which, as opposed to older settlements, take into account different environmental 
factors and extend over the areas less appropriate for building construction. Spatial 
characteristics have been identified in the test region of Prekmurje by using 
geographical information systems (GIS). In the analysis process, the raster data layer 
of the digital terrain model (DTM) and vector data layers of land use, flood areas and 
public hard infrastructure were included. The inductive and deductive models were 
designed, which vary in the research approach. The spatial characteristics considered 
during the 1850 building constructions were identified, as well as the extent to which 
the spatial conditions were taken into account in the periods of 1850–1890, 1890–
1940, 1940–1971 in 1971–2009 was determined. Furthermore, the thesis discusses 
the changes of the landscape from the year 1850 to 2009. In addition, tools have been 
developed to calculate the kappa-test of independence, overlapping layers, and to 
search for areas which were included in the analysis process. The results of the 
analysis have indicated changes in the settlements position and land use during the 
analysed periods, considering the slope, curvature, aspect, floodplains, soil moisture 
and windiness. 
 
KEY WORDS:  
GIS, location of settlements, Prekmurje, spatial modelling, vectorization of historical 
maps.
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1 UVOD 
 
Krajinsko raznolikost in prostorski razvoj so v Sloveniji opredeljevali zgodovinski 
dejavniki in naravne značilnosti prostora. Značilnosti slovenskega ozemlja so razgiban 
relief, velik delež kraškega sveta, sorazmerna omejenost ravninskega sveta, bogastvo 
površinskih in podzemnih voda, obmorska lega, biotska raznovrstnost, krajinska 
pestrost, ohranjenost kulturne dediščine in obsežna gozdnatost. Glede na skupne 
značilnosti območij Slovenije jo delimo na alpsko, dinarsko-kraško, sredozemsko in 
panonsko pokrajino (ARSO, 2010). 
 
Prostorski razvoj naselij je večinoma ekstenziven, kar pomeni, da se naselja pretežno 
širijo na nepozidane površine v okolico, manj pa se zapolnjujejo proste površine znotraj 
pozidanih območij (Drozg V. in sod., 2001). Delež prenove in prestrukturiranja 
obstoječih pozidanih površin je zanemarljivo majhen v primerjavi z novimi površinami, 
ki se namenjajo stanovanjski gradnji. Pri novogradnjah se uporablja pristop aditivnega 
tlorisa, kar pomeni, da se novi objekti dodajo obstoječim. Značilnost urbanizacije v 
Sloveniji je na eni strani razpršena poselitev z veliko množico manjših naselij, na drugi 
strani pa urbane zgostitve v dolinah in na ravninah. Vseh naselij je blizu 6.000 na 
20.000 km2 površine Slovenije (ARSO, 2010). Večina stanovanjskih območij je 
zazidana s prosto stoječimi enodružinskimi hišami, ki so prostorsko potratne (Drozg V. 
in sod., 2001). 
 
Obseg individualne stanovanjske gradnje, predvsem pa način njenega umeščanja v 
prostor, je povzročil korenite spremembe v podobi in strukturi naselij ter pejsažu 
pokrajine (Drozg V. in sod., 2001). Novejša stanovanjska gradnja večinoma ne 
upošteva avtohtone zasnove in naravnih determinant, ki so določale položaj in zasnovo 
nekdanjih agrarnih naselij, na primer naklon zemljišča, izpostavljenost visoki podtalnici 
ali poplavam, varovanje kakovostnih kmetijskih zemljišč, temveč se, v nasprotju s tem, 
širijo na površine, ki so nekoč veljale za nezazidljive. Marsikatero naselje je tako 
prestopilo »naravne meje«, s čimer se je izgubil ali vsaj zabrisal vtis premišljenosti 
prvotne lokacije. Takšna gradnja je dodaten razlog za povečevanje števila objektov, 
prizadetih v naravnih nesrečah, ki so sestavni del pokrajine. Treba jih je upoštevati v 
vsakdanjem življenju in načrtovanju rabe prostora (Natek K., 2007). Namesto 
prilagajanja naravnim razmeram so za zasnovo naselja postali pomembnejši drugi 
dejavniki, kot sta bližina infrastrukturnih objektov ali lep razgled (Drozg V. in sod., 
2001). Pri prostorskem načrtovanju je pomembna priprava in vrednotenje alternativnih 
rešitev (različic) (Marušič J., 1989), saj te nudijo več različnih rešitev pri urejanju 
prostora. Z vključevanjem različic in njihovim upoštevanjem pri načrtovanju prostora se 
lahko izognemo za gradnjo manj primernim območjem in s tem zmanjšamo možnost 
nastanka gospodarske škode zaradi pojavov naravnih nesreč. 
 
1.1 Problem 
 
V zadnjih desetletjih je prisoten trend širjenja naselij v mestnem in podeželskem okolju, 
katerega posledica je spreminjanje kulturne krajine. Za Slovenijo najočitnejši obliki 
posega v kulturno krajino sta spreminjanje nekdanjih kmetij v poletna bivališča in 
pojavljanje novogradenj na dotlej obdelovalnih površinah (Ogrin D., 2010). Širitev 
poselitve oziroma razvoj naselij na takšnih območjih je pogosto v konfliktu z 
ohranjanjem kakovostnih tal za kmetijstvo, ki prevladujejo v ravninskih predelih. Trajne 
spremembe rabe tal, ki so posledica pozidave, preprečujejo opravljanja temeljnih 
funkcij prsti in predstavljajo najbolj problematično obliko degradacije. Ta oblika 
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degradacije prsti je namreč povsem nepovratna in trajna, saj prvotnega stanja skoraj ni 
mogoče ponovno vzpostaviti (Repe B., 2009). 
 
Poleg pozidave kmetijskih zemljišč je pozidava v zadnjih desetletjih bolj usmerjena na 
zemljišča, ki so manj ugodna za pozidavo, na primer bolj strma, bolj mokra, bolj 
plazovita in od voda ogrožena (Marušič J., 2010). Gradnja na manj ugodnih zemljiščih 
za pozidavo pogosto povečuje tveganje za naravne nesreče, o katerih smo pogosto 
obveščeni s strani medijev. Neupoštevanje prisotnosti pokrajinskih danosti bistveno 
zmanjšuje zmogljivost okolja in njegove samoregulacijske zmožnosti, kar se 
navsezadnje kaže v škodi, ki jo povzročijo naravne nesreče. Posledice teh plačujejo 
prizadeti ljudje oziroma celotna družba preko izdatkov za državnegi in občinske 
proračune, in tudi s humanitarno pomočjo (Natek K., 2007). 
 
1.2 Namen in cilji naloge 
 
Namen naloge je z uporabo geografskih informacijskih sistemov (GIS) ugotoviti, katere 
pokrajinske značilnosti so upoštevala starejša naselja iz leta 1850 in kakšne 
upoštevajo novogradnje na testnem območju v Prekmurju. V ta namen sta izdelana 
modela, ki za prikaz območij, primernih za poselitev, uporabljata različna pristopa. 
Poleg tega je namen naloge izdelati model, ki prikazuje primerna območja za pozidavo, 
upoštevajoč naravne in ustvarjene danosti pokrajine. Značilnosti naselij bodo določene 
računsko in vizualno. Analize bodo izvedene v programskih paketih ArcGIS in SAGA 
GIS. 
 
Zastavljeni cilji so naslednji: 
1. Potrditi ali ovreči zastavljene hipoteze. 
2. Z opisnim deduktivnim in induktivnim modelom prikazati, katere prostorske 

značilnosti upoštevajo naselja in novogradnje. 
3. Izdelati model, ki upošteva naravne in ustvarjene danosti prostora, ter v ArcGIS-u 

izdelati orodje, ki ta model avtomatizira. 
 
1.3 Hipoteza 
 
Postavljene so tri delovne hipoteze: 
1. Naselja iz leta 1850 na Goričkem so grajena na sončnih, zavetrnih legah in pobočjih 

z manjšim naklonom. 
2. Naselja iz leta 1850 so oddaljena od vodotokov manj kot 500 m. 
3. Naselja se širijo na kmetijska zemljišča.
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2 TEORETI ČNE OSNOVE 
 
V teoretičnih osnovah so zajete značilnosti, s katerimi se naloga ukvarja: naselja, 
prostorske danosti in pokrajinske značilnosti širšega obravnavanega območja. Poleg 
teh so opisane lastnosti GIS. Teoretični del se zaključi z opisom uporabljenih 
statističnih testov. 
 
2.1 Zgradba naselja 
 
Pojem naselje lahko opredelimo z različnih vidikov: naselje kot fizično tvorbo, kot 
družbeno skupnost, ekonomsko enoto, kot kulturno civilizacijski fenomen. Naselje ni 
definirano samo ekonomsko, sociološko, zgodovinsko likovno, temveč vse to skupaj, je 
način postavljanja bivališč v skladu s stoletnimi izkušnjami in predstavami o življenju v 
skupnosti. Pojmovanje naselja je skladno z Gestalt teorijo, ki pravi, da celota naselja ni 
vsota njegovih sestavnih delov, temveč nova kakovost, nova kategorija, ki izhaja iz 
povezanosti sestavnih delov, saj posamezna zgradba predstavlja povsem drug 
pojmovni okvir kot skupina objektov. Splet hiš, prometnic, dvorišč in trgov 
obravnavamo kot fizično tvorbo naselja. Razporeditev teh elementov ni naključna, 
njihova medsebojna razmerja pa ustvarjajo zgradbo in podobo naselja. Razmerja med 
elementi se prilagajajo naravnim razmeram, neposrednemu okolju, s katerim je človek 
povezan in od njega odvisen. V zgradbi naselja so združeni in se različno izražajo 
številni dejavniki, ki oblikujejo in usmerjajo človekovo življenje. Razvrstitev elementov 
pa je hkrati odraz družbenih norm, predstav in vrednot v družbeni skupnosti. Zgradbo 
in obliko naselja narekuje življenje, ki ga narekuje slog življenja prebivalcev. Pri tem sta 
pomembna izobrazbena struktura prebivalstva in oddaljenost od delovnih mest, ki se 
kažeta v morfologiji naselja (Bole D., in sod., 2007). Morfologija naselja je odsev in 
odraz nečesa iz razmestitve fizičnih elementov naselja. Iz njihovih medsebojnih 
odnosov pa si lahko ustvarimo predstavo o duhovnih in družbenih vrednotah, ki so jih 
ljudje upoštevali pri urejanju svojih prebivališč. Poleg tega lahko iz zgradbe naselja 
razberemo razvojne faze in logiko prostorskega razvoja, ki ni pomembna le za 
razumevanje preteklosti, temveč tudi za načrtovanje prostorskega razvoja v 
prihodnosti. 
 
Od dejavnikov, ki oblikujejo fizični vidik naselja, so najpomembnejši: naravne (prirodne) 
razmere, tipi hiš, družbeni elementi, kulturni milje in čas. Skozi postavitev naselij se 
kaže način razumevanja in prilagajanja naravnim danostim, ki so v določenem 
zgodovinskem obdobju človeku predstavljale nepremagljivo oviro ali mu nudile 
življenjski prostor. Naravnim danostim se je bilo treba prilagoditi, kar je v skladu s 
sožitjem med naravo in človekom. Položaj naselij je izbran v prvi vrsti glede na naravne 
razmere oziroma dejavnike, ki varujejo prebivalce pred naravnimi nesrečami 
(poplavami, burjo, zemeljskimi plazovi) ali jim nudijo prednosti (zaščita, bližina 
kmetijskih površin in vodnih virov). Zaradi različnih naravnih pogojev so položaji naselij 
med pokrajinami različni, vendar podobni v isti pokrajini. Naravne razmere imajo na 
postavitev naselja neposreden vpliv, na primer s prevladujočim gradbenim materialom, 
in posreden vpliv, saj pogojujejo produkcijsko ekspozicijo, kar prav tako vpliva na 
morfologijo naselij. Prevladujoči dejavnosti sta prilagojena zasnova naselij, kot tudi tip 
hiše. Vpliv družbenega elementa se kaže v urejanju okolja v skladu s predstavami, 
duhovnimi vrednotami, načelom racionalnosti in v institucijah, ki upravljajo, postavljajo 
pravila in so nosilci družbene moči in oblasti. Posebno obliko družbenih razmerij 
predstavljajo družbene norme kot del kulturnega miljeja (kulturnega območja), ki 
predstavlja sklop naravnih, družbenih, gospodarskih in kulturnih dejavnikov določenega 
območja. V pojem kulturni milje sodijo živi ostanki preteklosti, ki se kot del tradicije in 
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kulturnega izročila ohranjajo in prenašajo prihodnjim rodovom. Takšni so naselja, 
sistem izrabe zemljišč oziroma kulturna pokrajina in arhitektura. Morfologija naselij se 
časovno spreminja skladno z družbenimi razmerji, gospodarskimi dejavnostmi in 
načinom življenja ljudi. Prilagojenost naselij naravnim razmeram kaže na to, da je 
človek v preteklosti živel povezan s prostorskimi danostmi. 
 
Do 20. stoletja ljudje niso s svojo dejavnostjo drastično vplivali na spreminjanje krajine, 
saj so bili posegi v prostor večinoma opravljeni ročno in ne s težko mehanizacijo, za 
katero ni ovir (Podobnikar T. in sod., 2008). Industrijska kultura in industrijska 
miselnost, ki je bila sprejeta kot edini način in merilo razvoja, se je sprva uveljavila v 
mestih in mestnih zaledjih, in ima za posledico prekinitev agrarne, vaške, na tradiciji 
sloneče kulture. Pojav je bil tako silovit, da je v treh desetletjih preplavil celotno 
podeželje. Kot odraz nove miselnosti in novega načina življenja so na podeželju, v 
pretežno agrarnem prostoru nastale zgradbe, katerih oblika je prinesena iz mestnega 
okolja in nimajo z naravnimi danostmi svoje okolice ničesar skupnega. Nastali razkorak 
med starim in novim je tako velik, da ga opredeljujemo kot degradacijo pokrajine. 
Neupoštevanje lokalnih krajinskih značilnosti ima za posledico poenotenje po različnih 
pokrajinah. Poseben problem v urejanju in oblikovanju prostora predstavlja velika 
razpršenost novogradenj po pokrajini, ki so postavljene izven strjenih naselij, 
najpogosteje v njihovi bližini ali kar sredi kmetijskih zemljišč. Postavljena so vzdolž 
prometnic, na mestih z dobrim razgledom, na pobočjih, ob industrijskih conah in še kje. 
Takšen način postavljanja objektov je marsikje v popolnem nasprotju avtohtonemu 
poselitvenemu vzorcu. Novi predeli naselij niso združeni s prvotnimi naselji, niti ne 
delujejo kot soseska. Nove dejavnosti ali nadomestki obstoječih se locirajo zunaj 
središča naselja, najpogosteje ob vpadnicah ali v bližini novih stanovanjskih sosesk. 
Poleg tega stavbe v središču naselja propadajo, nove pa rastejo običajno na kmetijskih 
površinah (Drozg V., 1995). 
 
2.2 Prostorske danosti 
 
Po Pogačniku (1999) delimo prostorske danosti na dve skupini: na naravne in 
ustvarjene danosti (antropogene). Naravne danosti predstavljajo naravne razmere v 
okolju, ustvarjene pa tiste, ki jih je za svoje potrebe ustvaril človek. Delitvi naravnih in 
ustvarjenih danosti po Pogačniku (1999) sta prikazani v prilogah A in B. Opisi kategorij 
pa zajemajo le tiste kategorije, ki so upoštevane v izvedbi praktičnega dela te naloge. 
Te so: nadmorska višina, naklon, vegetacijski pokrov, voda, osončenost površja in 
vetrovnost, ki jih uvrščamo v skupino naravnih danosti, in infrastrukturni objekti ter 
naprave, ki jih uvrščamo v skupino ustvarjenih danosti. 
 
2.2.1 Naravne danosti 
 
Nadmorska višina neke točke na zemeljskem površju je njena navpična oddaljenost od 
namišljene ravnine povprečne morske gladine, podaljšane pod kopno (Perko D., 2001). 
Skupaj z zemljepisno širino in zemljepisno dolžino sestavlja geografski koordinatni 
sistem in določa lego vsake točke v pokrajini. Osnova za določanje nadmorskih višin 
poljubnim točkam je omrežje stabiliziranih višinskih točk (Berdajs A. in Ulbl M., 2010). 
Nadmorska višina naselij je podana z višino neke izbrane točke v naselju, saj se višine 
delov naselja med seboj razlikujejo. Največkrat je nadmorska višina, merjena pri 
cerkvah. Nadmorska višina je kartografsko prikazana s črtkanjem, kotami, plastnicami 
ali izohipsami, barvnimi sloji in senčenjem (Podobnikar T., 2002). 
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Naklon (nagnjenost) ali inklinacija površja označuje kot med smerjo zviševanja površja 
in vodoravno ravnino. Izražamo ga v kotnih merah, običajno v ločnih stopinjah ali v 
odstotkih, ki povedo, za koliko dolžinskih enot se površje dvigne na razdalji stotih 
dolžinskih enot. Naklon površja sodi med najpomembnejše topografske značilnosti 
gradnje, saj so bolj strme lege splošno neuporabne za gradnjo (Drozg V., 1995). 
Gradnje v strmini so z inženirsko-tehničnega vidika zahtevnejše, saj pogosteje 
potrebujemo zahtevnejše temeljenje in boljšo hidroizolacijo. Poleg tega so tovrstne 
gradnje izpostavljene nevarnostim erozije ter slabšim pogojem za postavitev 
komunalne in prometne infrastrukture. Relief torej najpogosteje in najizraziteje določa 
zasnovo naselja. 
 
Osončenje površja je neposredno povezano z osvetlitvijo prostorov v stavbah, ima 
biološki in antibiotični pomen (Pogačnik, 1999), je vir toplotne energije in vpliva na 
podnebne razmere. Osončenje površja je povezano z ekspozicijo površja, ki pove, proti 
kateri strani neba je površje obrnjeno. Ekspozicijo površja lahko podamo s kotnimi 
stopinjami, pri čemer vrednosti 0° in 360° predstavljata sever, vred nost 180° pa jug. Na 
sliki 1 je južna ekspozicija prikazana rumeno, severna pa temno modro. Severna 
ekspozicija zajema vrednosti od 337,5° do 22,4°, se verozahodna od 22,5° do 67,4°, 
vzhodna od 67,5° do 112,4°, jugovzhodna od 112,5° d o 157,4°, južna od 157,5° do 
202,4°, jugozahodna od 202,5° do 247,4°, zahodna od  247,5° do 292,4° in 
severozahodna od 292,5° do 337,5° (Perko D., 2001).  
 

 
 

Slika 1: Smeri ekspozicije površja 
 
Vegetacijski pokrov predstavlja vegetacijo, ki pokriva zemeljsko površje. Sestavo 
vegetacijskega pokrova omejuje več dejavnikov: količina padavin, temperaturni režim 
in sestava tal. S krčenjem gozdov so nastale njive, travniki, pašniki, vinogradi in 
sadovnjaki. Z izsuševanjem so izginila močvirja. Z gozdnogospodarskimi ukrepi so 
povzročili izgubo pragozdov, regulacije tekočih vod pa spreminjajo obrežno vegetacijo. 
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Varstvo naravne dediščine velja za omejitev v urbanizaciji prostora, saj se pri 
načrtovanju naselij izogibamo zavarovanim območjem. Med območja varstva naravne 
dediščine sodijo narodni, regijski in krajinski parki, naravni rezervati, zavarovane 
rastlinske in živalske vrste in spomeniki oblikovane narave (ZON-UPB2). 
 
Posledica naravnega gibanja zraka je veter, ki nastane zaradi razlik v zračnem tlaku 
nad zemeljskim površjem. Gibanje zračnih mas deluje na človeško telo prijetno, če je 
šibko in moteče, če je močno ali če prinaša onesnaževala. Za upočasnjevanje vetra se 
uporabljajo različne pregrade: od zidov do zasaditve drevesnih vrst z gosto krošnjo. 
Veter intenziviramo glede na smer, od koder piha, njegovo hitrost in jakost pihanja. 
Hitrosti vetra so lahko razvrščene glede na 12-stopenjsko Beaufortovo lestvico, po 
kateri sodijo vetrovi hitrosti od 0,3 do 1,5 m/s med lahke sapice, do hitrosti 3,3 m/s med 
sapice, do hitrosti 5,4 m/s med šibke vetrove, do hitrosti 7,9 m/s med zmerne vetrove, 
do hitrosti 10,7 m/s med zmerno močne vetrove, do hitrosti 13,8 m/s med močne 
vetrove, do hitrosti 17,1 m/s med zelo močne vetrove, do hitrosti 20,7 m/s med viharne 
vetrove, do hitrosti 24,4 m/s med viharje, do hitrosti 28,4 m/s med močne viharje, do 
hitrosti 32,6 m/s med orkanske vetrove, nad to vrednostjo pa med orkane (Beaufort, 
2010). 
 
Voda ima pomembno vlogo med naravnimi danostmi prostora, ker je preskrba z vodo v 
zgodovini urbanizma pogojevala razvoj in rast naselij. Iz razpoložljive količine vode 
prav gotovo izvirajo možne rabe prostora: možne lokacije naselitve, industrija in druge 
rabe. Pri tem moramo imeti v mislih tudi zaščito pred poplavami. Na osnovi estetske, 
naravovarstvene ali rekreativne vrednosti vode se načrtujejo rekreativne in turistične 
cone. 
 
2.2.2 Ustvarjene danosti 
 
Infrastrukturna omrežja omogočajo delovanje regije oziroma posameznika na višjem 
nivoju (Pogačnik A., 1992). Skozi zgodovino so se potrebe po komunikacijah 
povečevale in zajemale vse širše potrebe za prenos materialnih dobrin, ljudi, idej in 
znanja. Poznamo štiri vrste infrastrukture: prometno (promet ljudi, blaga), energetsko 
(prenos energije elektrike, plina, nafte, tople vode), komunalno (vodovod, kanalizacija, 
razsvetljava, ravnanje z odpadki) in informacijsko (pošta, telefon, radio, televizija, 
internet, satelitski prenosi). Promet vključuje različne infrastrukturne objekte: različne 
tipe poti, na primer državne ceste (regionalne, občinske, lokalne), stanovanjske ceste, 
dovozne poti in zasebne ceste. V prometno omrežje sodijo tudi postajališča javnega 
prometa in bencinski servisi. Promet po cestah je najbolj razvejan in množičen, saj so 
po cestah, vsaj za osebna vozila, dostopne skoraj vse lokacije. Pri načrtovanju 
prometnih omrežij je treba upoštevati podatke o poselitvi, delovnih mestih, dohodku 
prebivalcev, lastništvu avtomobilov, kapacitetah šol, trgovin in druge. 
 
Energetska infrastruktura mora čim bolj enakomerno oskrbovati urban prostor. Oskrbo 
zagotavljajo proizvajalci (elektrarne) z ustreznim distribucijskim omrežjem. Pri prenosu 
energije imajo pomembno vlogo stroški investicije, proizvodnje energije, transporta, 
vzdrževanja prenosnih sistemov (daljnovodov) in varnost. Glede na vir ločimo 
obnovljivo (vodna, sončna, vetrna energija), neobnovljivo (fosilna goriva) in električno 
energijo. Pri načrtovanju energetske infrastrukture stremimo k čim večji uporabi 
obnovljivih virov in čim manjši porabi oziroma čim večjemu izkoristku električne 
energije. V energetsko infrastrukturo vključujemo objekte in naprave za proizvodnjo 
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energije, za zaloge in razdelilne centre. Sistemi za prenos energije so daljnovodi in 
transformacijske postaje s pripadajočo opremo. 
 
Najstarejši način prenosa telekomunikacijskih informacij je pošta, katere omrežje 
sestavljajo: poštni centri in poštno-telegramske in telefonske (PTT) zveze. V drugi 
polovici 20. stoletja so se začela uveljavljati radio-televizijska (RTV) omrežja. V 
novejšem času se vedno bolj uveljavljajo računalniška omrežja za prenos podatkov. 
Informacijski sistemi lahko temeljijo na žičnih ali brezžičnih povezavah. Objekti za 
brezžične povezave so locirani na vizualno izpostavljenih vzpetinah, v ravninskem 
svetu pa se v ta namen postavljajo stolpi. Brezžične zveze zahtevajo neprekinjeno 
vidno polje med oddajnimi in sprejemnimi antenami, zato v teh linijah ne sme biti 
previsokih objektov. 
 
Med komunalne dejavnosti sodijo oskrba s pitno vodo, odvajanje odpadnih vod, oskrba 
urbanih površin z javno razsvetljavo in odvoz odpadkov. Sisteme oskrbe s pitno vodo 
tvorijo zajetja izvirov, vodnjaki za črpanje iz vodonosnih plasti in vodovodi. Območja 
izvirov in območja črpališč morajo biti zavarovana pred možnim onesnaženjem voda. V 
najožjem varstvenem pasu ne sme biti nobenih rab, ki bi vir lahko onesnažile, v širšem 
varstvenem pasu sta lahko poselitev in kmetijstvo, v najširšem pa tudi obrt. 
 
Varstvo kulturne dediščine zajema kulturne spomenike, ki jih delimo na več skupin: 
zgodovinski (kraji pomembnejših dogodkov), umetnostni (stvaritve pomembnih 
umetnikov), arhitektonski (gradovi, cerkve), urbanistični (stara mestna jedra), ruristični 
(vaški robovi, vedute), tehniški (stari mlini), arheološki (ostanki naselbin), etnografski 
(ostanki ljudskega stavbarstva) in drugi spomeniki. Kulturno dediščino je treba varovati, 
saj predstavlja temelj narodne biti, spomina in soustvarja identiteto naselij in pokrajine. 
Varstvo mora biti aktivno, spomenikom je treba dati funkcijo in vsebino, ki omogoča 
njihovo vzdrževanje in obiskovanje. 
 
2.3 Pokrajinske značilnosti testnega območja 
 
Pokrajina Prekmurja zavzema severovzhodni del Slovenije na levem bregu Mure in je v 
zgodovini predstavljala mejni pas med Prekmurjem in preostalo današnjo Slovenijo 
(Buzeti T. in sod., 2004). Razlike na obeh straneh Mure so še vedno prisotne v 
gospodarskem razvoju, krajinski zgradbi prostora, stavbarstvu in jeziku, kar daje 
pokrajini pečat prepoznavnosti. Geomorfološki obliki Prekmurja sta obsežna ravnica na 
jugu in gričevje s kopastimi vrhovi in dolgimi, zaobljenimi, vzporedno potekajočimi hrbti 
na severu (Jančič M. in Marušič J., 1998). Pokrajinskih značilnosti Goričkega in 
predvsem njegova drugačnost od sosednjih pokrajin so razlog za ustanovitev 
krajinskega parka Goričko, ki je del trideželnega parka Goričko–Raab–İrseg. Krajinski 
park Goričko je bil ustanovljen leta 2003, leta 2004 pa je bil vključen v ekološko 
omrežje Natura 2000, katerega namen je ohranjati biotsko raznovrstnost v Evropi. 
 
Naravne danosti pokrajine, predvsem primerna sestava tal za obdelavo in ugodno 
celinsko podnebje, so že v neolitiku pripomogle k preoblikovanju krajine v kmetijska 
zemljišča, kar ima za posledico današnjo značilno kulturno krajino (Deu Ž., 2001). 
Dandanes se krajina spreminja z zaraščanjem robnih kmetijskih površin predvsem na 
Goričkem, ker se kmetovanje opušča zaradi slabih razmer in izseljevanja prebivalstva. 
Drugi vzrok spreminjanja krajine je gradnja, ki od podedovanih naselitvenih vzorcev 
odstopa tako po izbiri gradiva, kot tudi po obliki arhitekturnih členov (Jančič M. in 
Marušič J., 1998). Arhitektura starih prekmurskih domačij je povezana in zaznamovana 
z naravnimi danostmi in podnebjem, saj so za gradnjo uporabljali naravne materiale iz 
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svoje okolice. Najpogostejša gradbena materiala sta bila glina in les, ki ju je 
dopolnjevala slama. V Prekmurju sta poznana dva tipa gradnje kmečkih hiš; to sta 
butana in cimprana hiša (Buzeti T. in sod., 2004). Prva je izdelana tako, da je ilovica 
nabita med lesen opaž, pri drugi pa je konstrukcija iz tesarsko obdelanih brun obložena 
z glino, v katero je primešana slama. Zunanji, spodnji del sten je zaščitene s sivo barvo 
iz pepela, preostali del pa z apnenim beležem. Za oba tipa hiš je značilna pritlična 
gradnja. Butane in cimprane hiše je postopoma izrinila opečnata zidana hiša, ki se je v 
tem prostoru začela pojavljati na koncu 19. stoletja. Njeni značilnosti sta izstopajoča 
fasada in opečnata streha. 
 
2.3.1 Goričko 
 
Krajina Goričkega je pretežno gozdnata z manjšimi kmetijskimi površinami. Relief 
zaznamuje terciarni ravnik, ki so ga v preteklosti v mehki geološki podlagi oblikovale 
vode in poteka v dveh smereh: proti jugu in proti vzhodu (Perko D., 2001). Gričevje 
Goričkega delimo na dva dela: zahodnega, ki je bolj razgiban in leži med avstrijsko 
mejo in potokom Spunika (Radovski potok), in vzhodnega, ki leži med Spuniko in 
madžarsko mejo in je manj razgiban. Relief je strmejši in višji na severozahodnem delu 
Goričkega, kar je posledica trše geološke sestave karbonskih filitnih skrilavcev in 
bazaltnega tufa, kjer se nahaja najvišji vrh Sotinski breg (Kugla) s 418 m nadmorske 
višine. Vodna mreža z značilnimi občasnimi hudourniškimi potoki je enakomerno 
razvejana. V vlažnejših dolinah se pojavljajo drevesne vrste jelše, topola in vrbe, na 
bolj sušnih tleh pa gozdno združbo sestavljajo hrast, gaber in bukev. Gozdni rob je 
razgiban in se širi na kmetijske površine. Ravninska območja dna dolin in položnejša 
pobočja so intenzivne njivske in travniške površine, na dvignjenih in prisojnih legah je 
nekaj vinogradov in sadovnjakov. Na Goričkem je izrazito opuščanje njivskih površin in 
nasadov, predvsem sadovnjakov in širitev gozdne površine. Naselja na Goričkem so 
razvita v dveh oblikah: obcestne vasi v ali na robu dolin, redkeje na slemenih in v obliki 
razpršene gradnje zaselkov in posameznih kmetij po gričevju, brez jasno opaznih 
prostorskih pravil. Likovno oblikovanje stavb je na Goričkem poenostavljeno do gladkih 
trakastih obrob fasadnih odprtin in členitve fasadnih ploskev (Repe B., 2009). 
 

 
 

Slika 2:  Pogled iz Kruplivnika proti severovzhodu 
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2.3.2 Ravensko 
 
Ravninsko območje Prekmurja ustvarja na obeh bregovih reke Mure najširšo ravnino v 
Sloveniji. Relief Ravenskega je, kot že ime pove, pretežno raven, povprečni naklon 
površja znaša 0,5° in pada od severozahoda proti ju govzhodu. Povprečna nadmorska 
višina površja Murske ravnine je 184,2 m (Perko D., 2001). Kljub temu je na mikro ravni 
opaziti reliefne oblike: depresije, vzpetine, rečne nanose in ostanke strug, ki so nastale 
z delovanjem vode v preteklosti in upadajo z oddaljenostjo od rek. Naravno rastje 
Ravenskega je talno pogojeno, pri čemer prevladujejo gozdne združbe vlagoljubnih 
rastlinskih vrst: hrasta doba, topola, vrbe in jelše. Na Ravenskem prevladujejo veliki 
kompleksi njivskih površin, ki sestavljajo najintenzivnejšo kmetijsko pokrajino v 
Sloveniji (Repe B., 2009). Na ravnini so prsti debelejše v primerjavi z Goričkim in zato 
primerne za kmetijsko obdelavo. Naselja na Ravenskem so strjena, gručasta in/ali 
obcestna, pri čemer je gručasta oblika poselitve značilna za starejša jedra naselij 
(Marušič J., 1998). Naselja izgubljajo svojo prepoznavno obliko z novogradnjami in 
širitvijo zidave v novo vrsto vzdolž ceste. Panonska hiša, ki v teh krajih velja za 
tradicionalno arhitekturo, je že skoraj izginila, v večini primerov pa jo je nadomestila 
enonadstropna enodružinska hiša. Z opustitvijo lesenih stavb je izginilo tudi krašenje 
lesenih opažnih sten in okenskih odprtin (Deu Ž., 2001). Pri zidanih hišah se tradicija 
oblikovanja lesa kaže v ohranjenem krašenju konstrukcijskih elementov okenskih 
odprtin in vratnih kril. Čeprav se nove zidane stavbe na zunaj zelo razlikujejo od 
domačij iz lesa ali ilovice, je ohranjena razvrstitev prostorov, ki izhaja iz stare zasnove 
lesenih in ilovnatih objektov, grajenih na »ključ« ali na »kukelj«. Posebnost naselij so 
stavbe z monumentalno oblikovanimi stavbnimi podrobnostmi, kot so razgiban okras v 
ometu in štuku, pilastri, portalne police ter rastlinski in geometrijski motivi, ki izhajajo iz 
sosednje Madžarske. Likovno oblikovanje je v Prekmurju splošno razširjeno, vendar je 
okras bogatejši in zahtevnejši v ravninskih vaseh. Na Ravenskem k vtisu razpršene 
poselitve pripomorejo mrliške veže na pokopališčih med njivskimi površinami. Poleg 
njih se samostojno v prostoru in z velikokrat neprimerno arhitekturno obliko, ki kvarijo 
krajinsko sliko, pojavljajo tudi novogradnje stanovanjskih hiš, kmetijskih objektov, 
manjših obrtnih obratov in počitniških hišic (Marušič J., 1998). 
 

 
 

Slika 3 : Pogled iz Puconcev proti jugu 
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2.4 GIS 
 
Pojem GIS je okrajšava za geografske informacijske sisteme in ga definiramo kot 
informacijski sistem, ki ga sestavlja vsaj ena geografska komponenta. Ta predstavlja 
programski sistem procesov, temelječih na geografskih lastnostih podatkov. GIS tako 
omogoča kakršno koli uporabo geoprostorske tehnologije, določene z želeno 
funkcionalnostjo (Gould M. in Herring J. R., 2001) in predstavlja zbirko računalniških 
programov, namenjenih obdelavi podatkov s prostorsko komponento, po kateri se 
razlikuje od preostalih informacijskih sistemov. Prostorska komponenta podatkov 
podaja koordinatne pare, povezane z lokacijami na zemeljskem površju (Kvamme K. in 
sod., 1997). GIS temelji na geografski informacijski tehnologiji, ki zajema tehnologije za 
zbiranje in obdelovanje geografskih informacij. GIS se je v računalniški tehnologiji prvič 
pojavil okoli leta 1960 in se z razvojem računalniške tehnologije razvijal v različne 
smeri, kar ima za posledico več različnih definicij pojma GIS, prirejenih različnim 
področjem raziskovanja. Vse združuje definiranje pojma z opisom njegovih tehnoloških 
komponent, to so sistemske zmogljivosti, ter naborom operacij, ki jih opravlja. GIS-i 
omogočajo zajemanje prostorskih podatkov obdelavo in pretvorbo, organizirano 
hranjenje, ažuriranje prostorskih podatkov, vzdrževanje, obdelavo, iskanje, 
povezovanje, vizualno predstavitev, analiziranje, kombiniranje, razna poizvedovanja in 
napovedovanja na podlagi prostorskih podatkov, s čimer nudi podporo pri prostorskem 
odločanju (Bonham-Carter G. F., 1994). Značilnost GIS-ov je povezovanje fizičnih in 
družbeno-ekonomskih lastnosti. GIS-i so primerni za reševanje številnih vprašanj, ki 
imajo geografski značaj: 
� kaj se nekje nahaja, 
� kje se nekaj nahaja, 
� kakšne so spremembe, 
� ali obstaja določen prostorski vzorec. 
 
GIS se uporablja na različnih področjih: v kartografiji, geodeziji, fotogrametriji, pri 
daljinskem zaznavanju in pri vseh znanostih, ki so tako ali drugače povezane z 
zemeljskim površjem (biologija, agrikultura, okolijske znanosti, sociologija, geologija, 
geografija in druge). GIS torej vključuje vse postopke obdelave, analize in tehnike 
prikaza, ki so se v različnih znanostih razvijali vrsto let (Kvamme K. in sod., 1997). 
 
2.4.1 Prostorski podatki 
 
V GIS-ih poznamo dva osnovna načina shranjevanja podatkov, to sta vektorski in 
rastrski način (Kvamme K. in sod., 1997). Vektorski podatki temeljijo na predpostavki, 
da je možno vse pojave v prostoru definirati z določenim zaporedjem koordinatnih 
parov, pri čemer z njihovimi atributi povemo, kaj neko zaporedje koordinat predstavlja. 
Vektorske prostorske podatke delimo v tri skupine: točkovne, linijske in območne 
(poligonske). Kot že njihovo ime pove, so prvi predstavljeni s točko, torej z enim 
koordinatnim parom, linijski so linije in so predstavljeni z vsaj dvema koordinatnima 
paroma, ter poligonski, ki predstavljajo neka območja, njihovo obliko pa določajo vsaj 
trije koordinatni pari, pri čemer sta prvi in zadnji ista. 
 
Rastrske zbirke podatkov so sestavljene iz skupine kvadratkov, razporejenih v mrežo. 
S tem je položaj objekta definiran le s položajem vrstice in stolpca v dani mreži, iz 
česar sledi, da položaj objektov pri rastrskem zapisu ni tako natančen, kot pri 
vektorskem zapisu, saj položaj elementa realnega sveta ni podan s koordinatami, 
temveč s številko vrstice in stolpca v rastrski mreži. Tako je natančnost določanja 
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položaja objekta zelo odvisna od velikosti rastrske celice. Prav tako kot vektorski, tudi 
rastrski prostorski podatkovni sloji vsebujejo atribute. 
 
Atribute delimo na prostorske in neprostorske (Bonham-Carter G. F., 1994). Nahajajo 
se v atributnih tabelah posameznih slojev. Pri zapisovanju podatkov v atributne tabele 
se uporabljajo nominalne (numerične) in prostorske vrednostne lestvice. Podatki so 
pridobljeni iz meritev ali računsko na podlagi nekih drugih podatkov o objektu. 
Prostorski atributni podatki vsebujejo informacije o lokaciji (koordinate), topologiji in 
obliki objektov, medtem ko neprostorski atributni podatki opisujejo posamezne objekte, 
na primer starost, ime objekta, datum merjenja in podobno. Razvrstitev podatkov v 
atributni tabeli omogoča razna poizvedovanja, ki temeljijo na razredih atributne tabele 
in vrednostih posameznih objektov. 
 
2.4.2 Osnovne operacije v GIS 
 
Ker GIS-i omogočajo kar nekaj osnovnih operacij, so v tem poglavju navedene le tiste, 
ki so bile uporabljene v praktičnem delu naloge. Postopki, opisani v razdelkih od 
2.4.2.1 do 2.4.2.6, so analitični in omogočajo, da z njimi pridemo do novih informacij. 
Opisane operacije so povzete po Kvamme K. in sod. (1997). 
 
2.4.2.1  Spreminjanje razredov 
 
Pri delu s prostorskimi podatki je spreminjanje razredov zelo pogost postopek, saj 
lahko ugotovimo, da je prikaz preveč natančen in ne uporaben za želene analize. V 
rastrskem podatkovnem nizu se postopek izvede tako, da program, ki spremembo 
opravi, teče od celice do celice, pregleduje njeno vsebino in rezultate zapisuje v nov 
podatkovni sloj. V primeru vektorskega podatkovnega sloja je treba upoštevati, da se s 
spremembo atributov spremenijo mejne črte med posameznimi objekti. Nekateri 
razredi se združijo, njihove meje pa je treba posebej odstraniti iz baze podatkov. 
 
2.4.2.2  Prekrivanje 
 
Postopek prekrivanja uporabljamo takrat, ko imamo na voljo več kart z diskretnimi 
pojavi za isto območje in želimo ustvariti nov sloj, ki bi predstavljal vse možne logične 
kombinacije. Pri postopku prekrivanja vektorskih podatkovnih slojev združimo atributne 
podatke točkovnih, linijskih ali poligonskih grafičnih elementov. Postopek prekrivanja se 
izvede s spojitvijo atributnih tabel. Pri postopku prekrivanja rastrskih podatkovnih slojev 
enakih ločljivosti gre za prekrivanje vrednosti posameznih rastrskih celic (Drobne S. in 
Podobnikar T. 1999). 
 
2.4.2.3  Boolove operacije 
 
Boolova algebra , poimenovana po Georgu Boolu (1815–1864), ali dvojiška logika je 
matematični algoritem za operiranje z množicami ničel in enk. S tem vsaki rastrski 
celici pripišemo resničnost oziroma neresničnost dogodka. Uporaba slojev, zapisanih v 
dvojiški obliki, je še zlasti pomembna pri prostorskem modeliranju. Vsi Boolovi postopki 
se izvajajo nad celicami rastrske mreže, pri čemer dobljeni rezultat ne spremeni 
prostorskega položaja točke. V praktičnem delu je uporabljen Boolov operator And, ki 
predstavlja presek dveh vrednosti. Boolovi operatorji so še Or, Xor in Nor. Rezultat, ki 
ga poda ta operacija, imenujemo Boolova ploskev. 
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2.4.2.4  Območja oddaljenosti 
 
Območja oddaljenosti se ustvarijo tako, da se izračunajo ploskve oddaljenosti od 
objektov, ki nas zanimajo. Izračun ploskve oddaljenosti temelji na izračunu evklidske 
razdalje med izhodiščno točko in katero koli točko mreže v primeru rastrskih podatkov 
ter z določitvijo vzporednih linij na določeni oddaljenosti v primeru vektorskih 
podatkovnih slojev. Algoritem opravi štiri prehode zbirke podatkov, vsakokrat iz 
drugačne smeri. Dobljen rezultat se prerazporedi v dva razreda; v mrežne celice zunaj 
in v mrežne celice znotraj izbrane oddaljenosti od objekta. 
 
2.4.2.5  Izrezovanje, združevanje 
 
Operacija izrezovanja se uporabi, ko se na primer želimo v večjem sloju osredotočiti na 
manjši del, si ga natančneje ogledati oziroma analizirati. Z izrezovanjem napravimo 
ločen sloj, pri čemer iz celotne baze izvlečemo le tiste podatke, ki jih ožje obravnavano 
območje vsebuje. Združevanje predstavlja operacije, ki podatke prostorsko uredijo, jih 
postavijo enega poleg drugega in jih hkrati združijo v enoten podatkovni sloj. 
 
2.4.2.6  Model v GIS-ih 
 
Model v GIS-ih je poenostavljena predstavitev dela realnega sveta ali njegovih 
sistemov, ki obdrži dovolj njegovih lastnosti za nadaljnje analize (Ford A., 1999). 
Osnovni namen modeliranja v GIS-ih je prepoznavanje in interpretiranje geografskih 
vzorcev. GIS model se uporablja za oceno, opis ali združevanje na prvi pogled vidnih 
ali funkcionalnih vzorcev, ki se pokažejo tekom analiz. Ker v model vključujemo 
prostorske podatke, modeliranje v GIS-ih imenujemo prostorsko modeliranje. Poznamo 
več vrst delitev modelov. Po DeMers M. N., (2002) jih v osnovi delimo glede na namen, 
metodologijo in logiko, ki jo uporabljajo. Po namenu modele delimo na opisne in 
prediktivne, po metodologiji na stohastične in deterministične, po logiki pa na 
induktivne in deduktivne. Opisni modeli so namenjeni opisovanju raziskovalnih območij, 
pri čemer odgovarjajo na vprašanje, »kaj se nekje nahaja«. V nekaterih primerih 
opisujejo pogoje, ki ustrezajo posameznim dejavnostim in s tem odgovarjajo na 
vprašanje, »kaj bi se nekje lahko nahajalo«. Z opisnim modelom lahko poiščemo 
vzorce na podatkovnih slojih in jih primerjamo med seboj. Prediktivni model je 
namenjen odgovoru na vprašanja, »kje bi se lahko nekaj nahajalo«. Ta model sloni na 
dveh pristopih: prvi išče najboljše možno območje glede na podatke, drugi podaja več 
možnih območij, od katerih nekatera bolj, druga manj ustrezajo zahtevanim 
parametrom. Za stohastični model je značilno, da temelji na statističnih metodah, s 
katerimi se predvidi prisotnost ali odsotnost pojavov, medtem ko deterministični modeli 
temeljijo na znanih povezavah vzroka in posledice pojava. Induktivni model temelji na 
podatkih posameznega območja in je uporaben, kadar ne poznamo splošnih 
značilnosti območja. Deduktivni model temelji na neki predpostavki, ki je splošno znana 
ali jo postavimo sami. Nato to predpostavko preverimo na prostorskih podatkih (Dalla 
Bona L., 1994). Pri izdelavi modela moramo v čim večji meri definirati problem, vedeti, 
kakšne rezultate želimo in kakšne podatke imamo na voljo. Rezultat modela lahko 
prikaže območja z zahtevanimi lastnostmi na večjem območju od želenega, zato ga je 
treba umeriti na želeno območje (Clarke K. C. in Silva E. A., 2001). 
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2.4.3 ArcGIS 
 
Programski paket ArcGIS je komercialni produkt podjetja ESRI. Dosegljiv je v številnih 
različicah, ki se med seboj razlikujejo po lastnostih in funkcionalnostih, ki so prilagojene 
različnim načinom dela in zahtevam uporabnikov. Programski paket ArcGIS Desktop 
zajema več različic (ArcView, ArcEditor, ArcInfo), od katerih je po izboru orodij 
najobsežnejša različica ArcInfo. ArcInfo je sestavljen iz dveh aplikacij: ArcMap-a, v 
katerem poteka delo s podatkovnimi sloji, in ArCatalog-a, ki omogoča organizirano 
hranjenje podatkov. Paket ArcInfo vsebuje tudi programski vmesnik za uporabo 
programskega jezika Python, ki preko modula ArcPy dostopa do orodij in metod 
ArcGIS-a in s tem omogoča njihovo medsebojno združevanje v nova orodja. 
Komponenta ArcObject omogoča uporabo vseh geoprocesorskih orodij s pomočjo 
programskih skript. Uporaba skript je efektivna metoda za avtomatiziranje obdelave 
podatkov, saj omogoča izvajanje preprostih ali zapletenih procesov, brez posredovanja 
uporabnika. Poleg tega so skripte lahko pisane večnamensko, kar pomeni, da so 
uporabne večkrat v različnih primerih. Izdelane skripte se dodajo v zbirko orodij, s 
čimer se do njih dostopa enako kot do sistemskih orodij. ArcGIS podpira pisanje skript 
v različnih jezikih, od katerih je Pyhton najprimernejši za uporabo, podpira objektno 
usmerjen pristop v programiranju in je primeren za uporabo zapletenejših podatkovnih 
struktur (Tucker C., 2004). 
 
2.4.4 SAGA GIS 
 
Programski paket SAGA GIS je odprtokodni sistem, razvit na Univerzi Göttingen v 
Nemčiji. Namenjen je izvajanju prostorskih geomorfoloških analiz, saj vsebuje različne 
algoritme za prostorske analize in omogoča delo tako z vektorskimi, kot tudi rastrskimi 
podatkovnimi sloji. Podobno kot ArcGIS tudi SAGA dovoljuje uvoz različnih vrst 
datotek, kar izpolnjuje glavni predpogoj za izvedbo prostorskih analiz. Posebnost tega 
programskega paketa je seznam orodij, ki omogočajo analize in izdelave novih 
podatkovnih slojev iz prostorskega podatka DMR, kot so razne morfološke in 
hidrološke analize (Olaya V., 2004). 
 
2.5 Statistična testa 
 
Statistika predstavlja področje znanosti, ki se ukvarja z zbiranjem, organiziranjem, 
analiziranjem, interpretiranjem in uporabo podatkov za sprejemanje odločitev. Delimo 
jo na dve glavni veji: opisno statistiko, ki se ukvarja z zbiranjem, ureditvijo in prikazom 
podatkov, in inferenčno statistiko, ki se ukvarja z metodami za izračun verjetnosti in 
zbiranjem podatkov z namenom boljšega poznavanja populacije (Asadoorian M. O. in 
Kantarelis D., 2005). Med inferenčno statistiko uvrščamo tudi uporabljena statistična 
testa: kapa-test za izračun medsebojnega ujemanja podatkovnih slojev in test deležev, 
ki je bil uporabljen za vrednotenje hipotez. 
 
2.5.1 Kapa-test 
 
Kapa- (κ) test (Cohenov kapa-test) se uporablja za merjenje ujemanja med dvema 
binarnima spremenljivkama, ki sta referenčni podatek in izračunan podatek (Garrett J. 
M. in Viera J. A., 2005). V nalogi je bil uporabljen za izračun neodvisnosti posameznih 
podatkov. Izračun kapa-testa temelji na matrični tabeli (Tabela 1) z dvema vrsticama in 
dvema stolpcema. Stolpci predstavljajo vrednosti podatka 1 (na primer referenčnega 
podatka), vrstice pa vrednosti podatka 2 (izračunanega podatka). Celice z oznakami od 
a do d predstavljajo število rastrskih celic posameznega podatka. Oznaki a in d 
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predstavljata število celic, ko se oba podatka ujemata, b in c pa število celic, kjer se 
podatka ne ujemata. 
 

Tabela 1:  Matrična tabela z dvema binarnima podatkoma 
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Izračun temelji na razmerju med prisotnim in pričakovanim ujemanjem podatkovnih 
nizov. Za izračun kapa-testa je treba najprej izračunati stopnjo ujemanja p0, kot 
prikazuje enačba 1. 
 
Prisotno ujemanje p0: 
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a – število celic uspešnih primerov 
d – število celic neuspešnih primerov 
n – število vseh rastrskih celic 
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n0, n1 – vsoti števila rastrskih celic za podatek 1 
m0, m1 – vsoti števila rastrskih celic za podatek 2 
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Rezultat kapa statistike je numerična ocena ujemanja obeh nizov podatkov. Vrednosti 
kapa-testa se gibajo od 0 do 1, kjer 1 pomeni popolno ujemanje podatkov (Tabela 2). 
Če je vrednost negativna, kar se tudi lahko zgodi, to pomeni, da podatka sploh ne 
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vplivata drug na drugega. Ostale vrednosti kapa-testa se interpretirajo, kot je prikazano 
v spodnji tabeli. 
 

Tabela 2:  Interpretacija vrednosti rezultata kapa-testa 
 

Vrednost kapa-testa Stopnja ujemanja 
< 0 manj kot naključje 
0,01–0,20  zelo majhna 
0,21–0,40 majhna 
0,41–0,60 zmerna 
0,61–0,80 precejšnja 
0,81–0,99 skoraj popolna 

 
2.5.2 Test deležev 
 
Testiranje hipoteze (domneve) je statistični postopek, s katerim zastavljeno domnevo 
potrdimo ali ovržemo. Najprej je treba določiti ničelno in alternativno hipotezo, pri 
čemer ničelna hipoteza običajno podaja točno določeno vrednost nekega parametra, 
alternativna hipoteza pa območje vrednosti parametra. Za testiranje hipoteze je treba 
vedeti, kakšna je porazdelitev obravnavanih podatkov. Pri računanju statistike vzorca z 
binomsko porazdelitvijo in velikim številom pojavitev se binomska porazdelitev 
aproksimira na normalno porazdelitev (Cook I. in Upton G., 1996). V ta namen se 

uporabi člen 
n2

1
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kjer je: 
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p̂  – verjetnost uspešnih primerov 
p – verjetnost, določena z ničelno hipotezo 
q – verjetnost neuspešnih primerov 
r  – število rastrskih celic, kjer so uspešni primeri 
n – število vseh pojavitev 

 
Kritična vrednost z-testa za 99,9 % enostranski interval zaupanja znaša ±3,10. V 
primeru, da izračunana z-vrednost pade iz tega intervala, se ničelna hipoteza ovrže. 
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3 PRAKTI ČNI DEL 
 
Praktični del naloge se je začel s terenskim ogledom zahodnega dela Goričkega in 
Ravenskega, z opazovanjem prepleta različnih rab tal, starejših in novejših 
arhitekturnih prvin in ohranjenosti oziroma degradacije okolja. Na podlagi terenskega 
ogleda je bilo izbrano testno območje. Celoten praktičen del je bil izdelan z 
računalniškima programskima paketoma ArcGIS 9.3 in 10.0 ter SAGA GIS 2.0.5. 
Seznam uporabljenih ukazov z opisi je prikazan v prilogi C. 
 
3.1 Prostorski podatki 
 
Uporabljeni so bili rastrski in vektorski podatkovni sloji: digitalni model reliefa (DMR), 
digitalni ortofoto (DOF), historične karte iz obdobij 1850–1890, 1890–1940, 1940–1971, 
1971–2009, sloj rabe tal, sloj opozorilne karte poplav, sloj gospodarske javne 
infrastrukture (GJI) in sloj cest. Pri uporabi podatkov ni pomembno le, kaj nam podatki 
prikazujejo, temveč tudi, kateri podatki nam nekaj zadovoljivo prikažejo (Marušič J., 
1989). Tabela (v prilogi Č) prikazuje metapodatke uporabljenih podatkovnih slojev (leto 
izdelave, merilo, tip, vir). 
 
DMR podaja obliko zemeljskega površja v digitalnem zapisu, pri čemer za opis ploskev 
reliefa uporablja objekte, kot so linije padnic, točke vrhov oziroma ponorov in s tem 
omogoča različne analize površja. Iz DMR-ja lahko pridobimo veliko informacij o 
prostoru (Kvamme K. in sod., 1997). Najpogostejše so: prikaz zemeljskega površja v 
perspektivnem pogledu, prikaz reliefa s plastnicami, prikaz reliefa z analitičnim 
senčenjem, izdelava slojev vidnosti, izračun naklona površja in ekspozicije (Podobnikar 
T., 2006). Poleg tega je podatkovni sloj DMR-ja uporaben za ugotavljanje sprememb 
na Zemljinem površju, nastalih z antropogenimi ali naravnimi vplivi (Podobnikar T. in 
sod., 2008). Na sliki 4 je prikazan DMR s sivinsko hipsometrično lestvico, kjer so 
svetlejša območja višja. 
 

 
 

Slika 4: Prikaz DMR-ja s sivinsko hipsometrično lestvico za del Goričkega in 
Ravenskega (svetlejša območja so višja, temnejša nižja) 
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Historične ali stare karte vsebujejo geografske podatke, ki so osnova za rekonstrukcijo 
prostora v preteklosti. Pogosto vsebujejo podatke o fizičnih lastnostih prostora, ki so 
bile spremenjene ali celo izbrisane v procesu razvoja in niso zajete v nobenem dugem 
viru (Rumsey D. in Williams M. 2002). Za historične karte je značilna izdelava v 
manjših merilih, zaradi česar so podvržene manjši natančnosti in različnim načinom 
prikaza površja (črno-belo, različne barvne lestvice, šrafiranje), ki se spreminjajo tekom 
obdobij (Podobnikar T., 2011). 
 
Opozorilna karta poplav prikazuje obseg in pogostost poplav na posameznem 
območju. Glede na povratno dobo visokih voda ločimo: zelo redke poplave s povratno 
dobo 50 let in več, redke poplave s povratno dobo 10 do 20 let in pogoste poplave s 
povratno dobo 2 do 5 let. Na testnem območju se pojavljajo zelo redke poplave, ki jih 
imenujemo tudi katastrofalne poplave (Poplava, MORS). Povratna doba 50 let pomeni, 
da vsako leto obstaja 2 % verjetnost, da bo do poplav prišlo (Komac B. in sod., 2008). 
 
Podatkovne zbirke rabe tal so poenostavljen abstrakten prikaz določenega izseka 
zemeljskega površja (Rikanovič R., 2003). Raba tal se kaže v zastopanosti in 
razširjenosti zemljiških kategorij in sodi med prvine, ki najbolj prepoznavno 
zaznamujejo pokrajino. Podatkovne zbirke o rabi tal so uporabne pri analizi sprememb 
v pokrajini ter pri sledenju naravnih in družbenoekonomskih procesov. 
 
Za prikaz infrastrukturnih objektov so uporabljeni vektorski linijski podatki gospodarske 
javne infrastrukture (GJI). Namen GJI je prikaz zasedenosti prostora z objekti 
gospodarske javne infrastrukture. Med pridobljene podatke GJI sodijo podatki o cestah, 
električni energiji, vodovodu, kanalizaciji in elektronskih komunikacijah, od katerih 
samo podatka o elektronskih komunikacijah in električni energiji zajemata celotno 
testno območje. V sloju cestnega omrežja so prisotne napake, zato je bil uporabljen 
drug podatkovni sloj cest (GKB 25). 
 
3.2 Priprava podatkovnih slojev 
 
3.2.1 Testno območje 
 
Testno območje (slika 5) je pravokotne oblike, s stranicama pravokotnika 10 in 15 km. 
Locirano je na zahodu Goričkega ter pokriva del Goričkega in Ravenskega. Naselja, ki 
so zajeta v testno območje in so na Goričkem, so: Beznovci, Bodonci, Dankovci, Dolnji 
Slaveči, Grad, Kovačevci, Kruplivnik, Mačkovci, Motovilci, Moščanci, Otovci, Pečarovci, 
Poznanovci, Prosečka Vas, Radovci, Stanjevci, Šalamenci, Vadarci, Vaneča, Vidonci 
in Zenkovci. Naselja, ki so zajeta v testnem območju in so na Ravenskem, so: Borejci, 
Brezovci, Gederovci, Gorica, Krajna, Lemerje, Markišavci, Nemčavci, Polana, 
Predanovci, Puconci, Puževci in Strukovci. Testno območje obsega večji del občine 
Puconci in Grad ter manjše dele okoliških občin. Na Goričkem zajema del krajinskega 
parka Goričko. 
 
Nov vektorski sloj je bil ustvarjen v ArcCatalogu in nato vstavljen v ArcMap. Da ne ovira 
pogleda na ostale sloje, je prikazan popolnoma transparentno z rdečo obrobo. 
 
Postopek za izdelavo novega vektorskega sloja (ArcCatalog): 
Klik desnega miškinega gumba na želeno mesto -> New -> Shapefile -> Določen je bil 
poligonski tip sloja. 
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Postopek za izris pravokotnega območja (ArcMap): 
Editor -> Create New Feature -> Stranice pravokotnika so bile izmerjene z orodjem 
Measure -> Izdelano območje je bilo premaknjeno na želeno območje s pomočjo 
vojaške topografske karte (VGI). -> Save Edits -> Stop Editing 
 

 
 

Slika 5 : Prikaz testnega območja (rdeč pravokotnik) 
 
3.2.2 Sloji, pridobljeni iz DMR-ja 
 
DMR je služil za pridobitev slojev plastnic, naklona, ekspozicije, analitičnega senčenja, 
ukrivljenosti, vlažnosti in vetrovnosti. Vsi podatkovni sloji, razen vlažnosti in vetrovnosti, 
so bili izdelani v programskem paketu ArcGIS, vlažnost in vetrovnost pa v 
programskem paketu SAGA GIS. V SAGI GIS je treba sloj DMR-ja uvoziti v ustrezni 
obliki, ki jo pripravimo v ArcMap-u. Vsi sloji, ki so izpeljani iz DMR-ja, podajajo 
vrednosti zvezno. Sloja naklona in ekspozicija sta bila izdelana v merski enoti stopinj. 
Vrednosti ekspozicije so v razponu od –1 do 360, kjer vrednost –1 predstavlja ravno 
površje (Bobnar S. in sod., 2005). Pridobljeni podatkovni sloji naklona, ekspozicije, 
vlažnosti in vetrovnosti so rastrski sloji, medtem ko je podatkovni sloj plastnic vektorski 
linijski sloj. Podatkovni sloj za vetrovnost prikazuje območja, ki so vetru bolj in manj 
izpostavljena. Vetrovnost je izdelana posebej za Goričko in Ravensko ob predpostavki, 
da piha iz glavnih osmih smeri neba enako. Tako so bili pripravljeni sloji vetrovnosti iz 
smeri S, SV, V, JV, J, JZ, Z, SZ, ki so bili nato združeni v en sloj vetrovnosti. Sloj senc 
je bil izdelan kot pomoč za prikaz ostalih podatkovnih slojev, saj ta pod drugimi 
podatkovnimi sloji pripomore k nazornejšemu prikazu razgibanosti terena. Sloji 
pridobljeni iz DMR-ja so prikazani v prilogi D. 
 
Postopek izdelave podatkovnega sloja naklona (ArcMap): 
ArcToolbox -> Spatial Analyst Tools -> Surface -> Slope 
 
Postopek izdelave podatkovnega sloja ekspozicije (ArcMap): 
ArcToolbox -> Spatial Analyst Tools -> Surface -> Aspect 
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Postopek izdelave podatkovnega sloja plastnic (ArcMap): 
ArcToolbox -> Spatial Analyst Tools -> Surface -> Contour -> V uporabniškem 
vmesniku je, poleg vhodnega rastrskega podatka in mesta, kamor naj se izhodni 
rastrski podatek shrani, potrebno določiti tudi interval razpona med posameznimi 
plastnicami. Izdelane so bile z intervalom 20 m. 
 
Postopek za izdelavo podatkovnega sloja senc (ArcMap): 
ArcToolbox -> Spatial Analyst Tools -> Surface -> Hillshade -> Uporabljeni sta bili 
vrednosti azimuta 315° in zenitne razdalje 45°. 
 
Postopek za izdelavo primernega formata DMR-ja za uvoz datoteke sloja v SAGI GIS 
(ArcMap): 
ArcToolbox -> Conversion Tools -> From Raster -> Raster to ASCII -> Izstopnemu 
podatku določiti končnico ».asc«. 
 
Postopek za izdelavo sloja vetrovnosti (SAGA GIS): 
Import/Export -> Import ESRI Arc/Info grid -> Terrain Analysis -> Morphometry -> Wind 
Effect -> V uporabniškem vmesniku je treba izbrati podatek DMR-ja in določiti azimut, 
iz katerega naj veter piha. 
 
ArcMap: 
Orodna vrstica Spatial Analyst -> Raster Calculator -> V programski vmesnik so bili 
vneseni vsi sloji vetra in med seboj sešteti. 
 
Postopek za izdelavo sloja vlažnosti (SAGA GIS): 
Terrain Analysis -> Hydrology -> SAGA Wetness Index -> V uporabniškem vmesniku 
se izbere sloj DMR-ja, na podlagi katerega se izdela sloj vlažnosti tal. 
 
Postopek za izdelavo sloja ukrivljenosti površja (ArcMap): 
ArcToolbox -> Spatial Analysed Tools -> Surface -> Curvature 
SAGA GIS: 
Grid Filter -> Gaussian Filter 
 
3.2.3 Sloj območij Goričkega in Ravenskega 
 
Poligonski sloj območij Goričko in Ravensko je bil izdelan iz slojev testnega območja in 
sloja plastnic. Najprej je bilo treba spremeniti sloj plastnic, in sicer tako, da je ostala le 
plastnica z nadmorsko višino 220 m, po kateri poteka meja med Goričkim in 
Ravenskim (Perko D., 2001). Vse druge plastnice sem izbrala s poizvedovanjem za 
vrednostmi v atributni tabeli in jih nato izbrisala. Sloj testnega območja je bil nato 
prerezan po plastnici višine 220 m. S tem sta bila izdelana sloja območja Goričko in 
območja Ravensko (slika 6). 
 
Postopek za pripravo sloja plastnice z višino 220 m (ArcMap): 
Editor -> Start Editing -> V polju Target sem določila sloj plastnic. 
Klik desnega gumba miške na sloj plastnic. -> Open attribute table -> Options -> Select 
by attributes -> Prikaže se programski vmesnik, kamor sem vpisala izraza 
»CONTOUR>200« in »CONTOUR<240« -> Apply 
 
Postopek za izdelavo območja Goričkega (ArcMap): 



 21 

Start Editing -> V polju Target sem določila testno območje, v polju Task pa Cut 
Polygon Feature -> klik na Sketch Tool -> Klik z desnim gumbom miške na plastnico.  
-> Replace Skech -> F2 -> Save Edits -> Stop Editing 
 
Postopek za izdelavo območja Ravenskega (ArcMap): 
Arc Toolbox -> Analysis Tools -> Overlay -> Update 
Start Editing -> Klik desnega gumba miške na predhodno generiran sloj. -> Open 
Atributte Table -> Klik z miškinim gumbom na poligon Goričkega. -> Delete -> Save 
Edits -> Stop Editing 
 

 
 

Slika 6:  Območje Goričkega (zeleno) in Ravenskega (oranžno) 
 
Iz podatkovnega sloja rabe tal za leto 2009 so bili pripravljeni podatkovni sloji, ki 
predstavljajo rabo tal v letih 1971, 1940, 1890 in 1850. Pripravljeni so bili po postopku 
vektorizacije kart. Vektorizacija je postopek, pri katerem se rastrski podatki spremenijo 
v vektorske. Sam postopek je vključeval metodo odzadnjega urejanja (ang. backward 
editing), kar pomeni, da so bili sloji rabe tal pripravljeni v vrstnem redu od najnovejšega 
(2009) do najstarejšega (1850). Postopek poteka tako, da je bil najprej uporabljen sloj 
rabe tal za leto 2009 in karta, ki je nasledna starejša, to je vojaška geografska izmera 
(VGI) iz leta 1971. Sloj rabe tal 2009 je bil nato popravljen glede na karto VGI. V 
pomoč pa je bila karta Lendavskih goric. S tem dobimo nov sloj rabe tal, ki predstavlja 
stanje v letu 1971. Po enakem postopku so bili pripravljeni še preostali sloji rabe tal. Za 
izdelavo slojev rabe tal iz preteklosti so bile uporabljene historične karte, ki so že bile 
georeferencirane (Podobnikar T., 2011) in so navedene v prilogi E. Pomožne 
(sekundarne) karte so bile v pomoč pri interpretaciji primarnih kart. 
 
3.2.4 Sloj rabe tal 2009 
 
Vsi postopki kopiranja, uvažanja ali izvažanja vektorskih slojev so potekali v ArcGIS-ovi 
aplikaciji ArcCatalog, kjer sem v ta namen ustvarila osebno geozbirko (ang. Personal 
Geodatabase). Pridobljen sloj rabe tal 2009 je bil sestavljen iz pravokotnikov (slika 7), 
zaradi česar so bili poligoni enakih kategorij razdeljeni na vsaj dva dela. Pri tem je 
prišlo do napake v atributni tabeli, zato je bil vektor oblike .shp pretvorjen v ArcInfo 
format coverage in ponovno vstavljen v geozbirko. Razdružene poligone sem ponovno 
združila, med tem postopkom pa je sloj rabe tal spremenil obliko zapisa iz coverage v 
shape podatkovni sloj. V atributni tabeli sloja rabe tal za leto 2009 so bile rabe podane 
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kot šifre, zato sem za razumevanje prikaza sloja uporabila Šifrant in opis dejanske rabe 
kmetijskih in gozdnih zemljišč. Prvotne in spremenjene kategorije rabe tal so prikazane 
v prilogi F. 
 

 
 

Slika 7 : Sloj rabe tal 2009, sestavljen iz pravokotne mreže 
 
Postopek stvaritve geozbirke (ArcCatalog): 
Personal Geodatabase -> New -> Feature Dataset 
Klik desnega gumba miške na osebno geozbirko. -> Feature Dataset -> Import -> 
Feature Class (single) 
 
Postopek za izrez sloja rabe tal 2009 na velikost testnega območja (ArcMap): 
Toolbox -> Analysis Tools -> Extract -> Clip 
 
Postopek za pretvorbo vektorskega sloja v coverage podatkovni sloj (ArcCatalog): 
Klik desnega gumba miške na sloj rabe tal v .shp obliki. -> Export -> To Coverage -> 
Klik na Feature Dataset v geozbirki. -> Import Coverage 
 
Postopek za združevanje prekinjenih poligonov (ArcMap): 
Toolbox -> Data Management Tools -> Generalization -> Dissolve 
 
Postopek za preklasifikacijo kategorij rabe tal 2009 (ArcMap): 
Editor -> Start Editing -> V polju Target je bil določen sloj rabe tal 2009. 
Klik desnega gumba miške na sloj rabe tal 2009. -> Open Atribute table -> Options -> 
Select by attributes -> V programski vmesnik sem vpisala izraz: RABA ID = 1100. 
Editor -> Attributes -> Šifra 1100 je bila spremenjena v kategorijo 1. Enako so bile 
prekategorizirane šifre do 4220. Po tem postopku so bile ustvarjene še kategorije rabe 
tal 2, 4 in 5. 
 
Editor -> Save Edits -> Stop Editing. 
 
3.2.5 Sloji rabe tal 1971, 1940, 1890 in 1850 
 
Z namenom pohitritve postopka popravljanja sem poligon kategorije 4 celotnega 
testnega območja razrezala na več delov. Zaradi boljše preglednosti pri pripravljanju 
sloja rabe tal 1971 sem celotno testno območje razdelila na pravokotne sektorje. Vsi so 
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bili prikazani brezbarvno, z rdečo obrobo. Postopek popravljanja je nato potekal tako, 
da je bil najprej popravljen sloj rabe tal 1971 znotraj enega pravokotnika, nato 
naslednjega in tako naprej. Z risanjem pravokotnikov sem se izognila temu, da bi 
kakšen del sloja rabe tal ostal nepregledan in zato nepopravljen. Po vsakem popravku 
znotraj pravokotnika sem le-temu spremenila barvo, da ne bi prišlo do nejasnosti, kateri 
pravokotniki so bili popravljeni in kateri ne. Najprej je bila popravljena kategorija rabe 
tal z RABA_ID = 5, nato kategorija 4 in na koncu še kategorija 2. Po končanem 
popravljanju sloja je bila preverjena topologija, to je odnos med sosednjimi poligoni. V 
uporabniškem vmesniku za določitev lastnosti topologije je bil izbran sloj rabe tal 1971 
in določena pravila, po katerih naj se topologija preveri. Izbrani pravili sta bili »ne sme 
imeti vrzeli« (ang. must not have gaps) in »ne sme prekrivati« (ang. must not overlap), 
s čimer se prepreči, da bi se sosednji poligoni med seboj prekrivali in/ali, da se med 
njimi pojavi območje brez vrednosti (ESRI, 2003). Sloj za preverjanje topologije je bil 
dodan v ArcMap. Na sliki 8 je prikazan primer sloja rabe tal. 
 

 
 
Slika 8:  Prikaz sloja rabe tal za leto 1850 (rjava – kmetijska zemljišča, zelena – gozdne 

površine, rdeča – urbane površine) 
 
Postopek za izdelavo sloja rabe tal 1971 (ArcCatalog): 
Geozbirka -> Klik desnega gumba miške na sloj rabe tal 2009. -> Copy 
Klik desnega gumba miške znotraj Feature Dataset. -> Paste 
Klik desnega gumba miške na prekopiran sloj. -> Rename -> Sloj je bil preimenovan v 
raba_tal_1971. 
 
Postopek za določitev transparentnosti sloja rabe tal 1971 (ArcMap): 
Properties -> Display -> Transparent -> 50 % 
 
Postopek za popravljanje sloja rabe tal 1971 (ArcMap): 
Editor -> Snapping -> Obkljukane so bile možnosti: Vertex, Edge, Edit Sketch in Edit 
sketch edges. 
Editor -> Start Editing -> Cut polygon features ali Create new feature 
Attributes -> Zamenjajo se kategorije rabe tal. 
Editor -> Save Edits -> Stop Editing 
 
Postopek za izris pravokotnikov za pomoč pri pripravljanju slojev (ArcMap): 
Drawn -> New rectangle 
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Klik desnega gumba miške na narisan pravokotnik. -> Properties -> Symbol -> 
Pravokotniku se izberejo barva in širina obrobe ter barva notranjosti. 
 
Postopek za izdelavo sloja za preverjanje topologije (ArcCatalog): 
Geozbirka -> Feature Dataset ->New -> Topology -> Določen je bil sloj rabe tal 1971 in 
pravili Must Not Have Gaps in Must Not Overlap. 
 
Postopek za preverjanje topologije (ArcMap): 
Editor -> Start editing 
Topology -> Validate Entire Topology -> Klik na desni miškin gumb na posamezni 
napaki. -> Create New Feature ali Merge 
Editor -> Save edits -> Stop Edits 
Toolbox -> Data Management Tools -> Generalization -> Dissolve 
 
3.2.6 Sloji naselij 
 
Podatkovni sloj naselij za leta 2009, 1971, 1940, 1890 in 1850 (slika 9) so bili izdelani 
iz sloja rabe tal iz istih let. Naselja in ceste so v sloju rabe tal določeni z istim 
poligonom z enako kategorijo. Poleg cest kategorija naselij vključuje tudi industrijske 
cone in pokopališča. Za pripravo sloja naselij je bilo treba na vseh slojih rabe tal ločiti 
ceste od naselij, na slojih rabe tal za leta 2009 in 1971 pa še industrijske cone. Prav 
tako je bilo izločeno pokopališče, ki je izven naselja. Industrijske cone in pokopališče 
so bili na sloju rabe tal določeni in izločeni s pomočjo DOF-a in karte VGI. 
 
Postopek za pripravo slojev naselij (ArcMap): 
Editor -> Start Editing 
Editor -> Cut Polygon Features 
Editor -> Save Edits -> Stop Editing 
 

 
 

Slika 9:  Prikaz vektorskega sloja naselij (rdeča) za leto 1850 
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3.2.7 Izdelava sloja novogradenj 
 
Novogradnje so na novo zgrajeni objekti (stavbe, ceste), od katerih sloj novogradenj 
zajema na novo zgrajene stanovanjske objekte v določenem obdobju. Iz slojev naselij 
za obdobja 1850–1890, 1890–1940, 1940–1970, 1971–2009 (slika 10) so bili izdelani 
sloji novogradenj za ta ista obdobja. Izdelani so bili z uporabo Boolovega operaterja 
XOR, ki vrne pravilno, kjer je pravilen prvi ali drugi podatkovni sloj. Na takšen način 
sem dobila le novogradnje iz določenega obdoja. 
 
Postopek za izdelavo slojev novogradenj (ArcMap): 
ArcToolbox -> Spatial AnalystTools -> Math -> Logical -> Boolean XOR 
 

 
 

Slika 10:  Prikaz sloja novogradenj (rdeča) iz obdobja 1971–2009 
 
3.2.8 Sloj gozdnih površin in kmetijskih zemljišč 
 
Sloj za kmetijska zemljišča za leta 1850, 1890, 1940 in 1971 (slika 11) je bil pripravljen 
iz slojev rabe tal s preklasifikacijo kategorij. Sloj rabe tal je bil prekopiran in 
preimenovan. Vse vrednosti kategorije RABA_ID, razen kategorije kmetijskih zemljišč, 
so bile spremenjene v RABA_ID = 0. Sloj gozdnih površin je bil pripravljen po enakem 
postopku kot sloj kmetijskih zemljišč, s to razliko, da so bile vse kategorije RABA_ID 
ponovno klasificirane v vrednost RABA_ID = 0, kategorija RABA_ID = 2 pa je bila 
spremenjena v RABA_ID = 1. 
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Slika 11:  Prikaz vektorskega sloja gozdne površine (zelena) in kmetijskih površin 
(rjava) za leto 1971 

 
3.2.9 Sloji GJI 
 
Priprava slojev GJI je zajemala le združevanje manjših linijskih objektov v večje 
objekte. Združeni so bili tako, da novonastali linijski sloj za električno energijo 
predstavlja daljnovode (prostozračne, kabelske in kablovode) (slika 12), sloj za 
komunikacije predstavlja fiksno prizemno telefonsko omrežje, sloj za vodovode pa 
predstavlja vodovodno kanalizacijo in kanalizacijsko omrežje. 
 
Postopek združevanja (ArcMap): 
ArcToolbox -> Data Management Tools -> Generalization -> Dissolve 
 

 
 

Slika 12:  Primer sloja električnega omrežja (črna) 
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3.2.10  Sloj poplavnega območja 
 
Podatkovni sloji katastrofalnih poplav (slika 13) in GJI imajo vrednost le na območju 
poligona, v svoji okolici pa ne. Ker je pri nadaljnjem delu upoštevana tudi njuna okolica, 
je tudi tej treba določiti vrednost. Postopek določitve kategorije preostalemu območju, 
kjer ni poligona, je bil za enak za vse omenjene sloje. 
 
Postopek za določitev vrednosti na delu območja, ki nima vrednosti (ArcMap): 
Arc Toolbox -> Analysis Tools -> Overlay -> Update -> Obkljukamo polje Borders. 
ArcToolbox -> Data Management Tools -> Generalization -> Dissolve 
 

 
 

Slika 13:  Prikaz sloja poplavnega območja z dvema vrednostma: poplavnim območjem 
(modra) in okolico (rumena) 

 
3.2.11  Sloj voda za leto 1850 
 
V ArcCatalogu je bil narejen nov sloj, kot je že opisano v razdelku 3.2.1. Ta je bil 
vstavljen v ArcMap. Nanj so bili prekopirane vode Iz sloja rabe tal za leto 1850, nato pa 
združene s slojem območja. S tem imajo vode drugačen ID od preostalega območja. 
Ker so potoki na sloju rabe tal prekinjeni na mestih, kjer jih prečka cesta ali naselje, so 
bile te prekinitve potokov ročno dodane. Manjkajoči deli potokov so bili izrezani od 
preostalega območja in prekategorizirani v ID = 1, ki predstavlja vode. Pri izrezovanju 
manjkajočih delov potoka je bilo uporabljeno orodje snapping, ki omogoča natančnejše 
izrezovanje. Nastavitve tega orodja so bile enake, kot so že opisane v razdelku 3.2.5. 
Zaradi težave pri uporabi nadaljnjih funkcij se je izkazalo, da je treba vsakemu potoku 
določiti svoj ID. Na novo določeni ID-ji obsegajo vrednosti od 0 do 12, pri čemer 
vrednost 0 predstavlja testno območje, vrednosti od 1 do 10 potoke, pri vrednostih 11 
in 12 pa gre za manjši stoječi vodi, ki sta prav tako zajeti v ta sloj (slika 14). 
 
Postopek za izdelavo sloja voda za leto 1850 (ArcMap): 
Editor -> Start Editing -> Poligon potokov je bil skopiran na nov sloj. -> ArcToolbox -> 
Analysis Tools -> Overlay -> Union -> Editor -> Snapping -> Cut Polygon Features -> 
Attributes -> Vodam se določi nove ID vrednosti. -> Save Edits -> Stop Editing 
ArcToolbox -> Data Management Tools -> Generalization -> Dissolve 
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Slika 14:  Prikaz sloja vodotokov (modra) leta 1850 
 
3.2.12  Sloji oddaljenosti od voda za leto 1850 in slojev oddaljenosti od GJI 
 
Z uporabo orodij za računanje oddaljenosti dobimo območje, ki je poljubno oddaljeno 
od nekega objekta. Izdelanih so bili štirje sloji oddaljenosti od potokov v letu 1850, in 
sicer: oddaljenost 200 m, 300 m, 400 m in 500 m (slika 15). Vrednosti so izbrane ob 
predpostavki, da se naselja nahajajo v bližini vodotokov in ker me je zanimalo 
spreminjanje števila naselij po 100-metrskih pasovih. Najmanjša upoštevana 
oddaljenost je 200 m, ker menim, da je ta razdalja za dostop do vode enako ugodna 
kot 100-metrska oddaljenost. Največja upoštevana razdalja je 500 m, ki pri prenosu 
vode že predstavlja večji napor. Postopek priprave slojev oddaljenosti je enak za sloje 
vode in sloje GJI. 
 

 
 

Slika 15:  Prikaz sloja oddaljenosti 200 m (svetlo oranžna), 300 m (temno oranžna), 
400 m (rdeča), 500 m (vijolična) od vodotokov leta 1850 

 
Postopek za izdelavo območja oddaljenosti (ArcMap): 
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Arc Toolbox -> Analysis Tools -> Proximity -> Buffer -> Med parametri, ki jih je treba 
izpolniti v uporabniškem vmesniku, se nahaja tudi razdalja (oddaljenost) od objekta. 
Dobljena območja oddaljenosti so se med seboj prekrivala in ker je območje vsakega 
posameznega potoka privzelo enak ID kot potok, se je pri nadaljnjem delu pojavila 
težava, ki je bila odpravljena z uporabo topologije. Za tem so bili vsi ID območij 
oddaljenosti z vrednostmi od 1 do 12 spremenjeni v ID = 1. 
ArcToolbox -> Data Management Tools -> Generalization -> Dissolve 
 
3.2.13  Izrez vektorskih slojev na območje Goričkega in Ravenskega 
 
Vsi vektorski sloji so bili razrezani na območje Goričkega in Ravenskega (slika 16). Za 
izrez vektorskih podatkov sta bila uporabljena vektorska sloja Goričkega in 
Ravenskega. 
 
Postopek za izrez (ArcMap): 
Toolbox -> Analysis Tools -> Extract -> Clip 
 

 
 

Slika 16:  Prikaz vektorskega sloja naselij (rdeča) za pred in po izrezu na območje 
Goričkega 

 
3.2.14  Pretvorba vektorskih v rastrske podatkovne sloje 
 
Vsi vektorski sloji, razen testnega območja, območja Goričkega ter Ravenskega in 
slojev plastnic, so bili zaradi nadaljnjih analiz pretvorjeni v binarne rastrske sloje. Sloji 
vseh treh območij so za nadaljnje delo primernejši v vektorski obliki, zato jih ni treba 
pretvarjati v rastrsko obliko. Po pretvorbi slojev iz vektorske v rastrske morajo ti 
vsebovati diskretni vrednosti 0 in 1, pri čemer vrednost 0 predstavlja neprimerno 
območje oziroma območje, kjer objekta ni, vrednost 1 pa primerno območje oziroma 
območje, kjer se objekt nahaja. Takšno obliko slojev imenujemo binarni sloji. Sloji, ki so 
v vektorski obliki vsebovali več vrednosti, so bili ponovno klasificirani z vrednostmi 0 in 
1. Vsi izdelani rastrski sloji imajo velikost celice 12,5 metra, enako kot podatkovni sloj 
DMR. Na sliki 17 je prikazana primerjava vektorskega in rastrskega podatkovnega 
sloja. 
 
Postopek pretvorbe vektorskih v rastrske sloje (ArcMap): 
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ArcToolbox -> Conversion tools -> To Raster -> Polygon To Raster 
 
Postopek preklasifikacije rastrskega sloja (ArcMap): 
ArcToolbox -> 3D Analysed Tools -> Raster Reclass -> Reclassify -> V stolpcu New 
Values sem vpisala nove vrednosti, ki sta 0 in 1. 
 

 
 

Slika 17:  Prikaz vektorskega (levo) in rastrskega (desno) sloja poplavnega območja 
 
3.2.15  Izdelava atributne tabele 
 
Orodje za prikaz območja potencialnih širitev naselij zahteva atributne tabele z 
binarnimi vrednostmi vseh vhodnih podatkov. Rastrski podatkovni sloji, pridobljeni iz 
DMR-ja, ne vsebujejo atributne tabele, zato jih je treba izdelati, ker analize temeljijo na 
vrednostih iz atributnih tabel. 
 
Postopek za izdelavo atributne tabele (ArcMap): 
Orodna vrstica Spatial Analyst -> Raster Calculator -> V programski vmesnik se vpiše 
izraz Int ( [raster] * 10 ). 
ArcToolbox -> 3D Analysed Tools -> Raster Reclass -> Reclassify -> V stolpcu New 
Values je treba vpisati nove vrednosti, ki sta 0 in 1. 
 
3.2.16  Izrez rastrskih slojev na območji Goričkega in Ravenskega 
 
Rastrski sloji, ki so bili izpeljani iz DMR-ja, predstavljajo celotno testno območje, zato 
so bili izrezani na območji Goričkega in Ravenskega (slika 18). Pri tem sta bila 
uporabljena vektorska sloja območij Goričkega in Ravenskega. 
 
Postopek za izrez rastrskega sloja na obliko vektorskega sloja (ArcMap): 
ArcToolbox -> Data Management Tools -> Raster -> Raster Processing -> Clip -> Za 
izrez rastrskega na obliko vektorskega podatka je treba označiti možnost za izrez po 
vstavljenem vektorskem podatku. 
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Slika 18:  Prikaz rastrskega sloja naselij (rdeča) pred in po izrezu na območje 
Ravenskega 

 
3.2.17  Združevanje rastrskih slojev 
 
Pri združevanju rastrskih slojev sta bila združena dva binarna rastrska sloja. Z njuno 
združitvijo dobimo rastrski sloj s štirimi vrednostmi (slika 19), ki so kombinacija 
združenih binarnih rastrov. Takšen sloj je primeren za izračun kapa-testa neodvisnosti 
ali izračun prekrivanja med rastrskima slojema, ki sta bila združena. 
 
Postopek za združevanje rastrskih slojev (ArcMap): 
ArcToolbox -> Spatial Analyst Tools -> Local -> Combine 
 

 
 

Slika 19: Primer primerjave rastrskih rezultatov modela z naselji iz obdobja 1850 
(rdeča in modra – naselja, rdeča in zelena – Boolova ploskev, rdeča – prekrivanje 

naselij z Boolovo ploskvijo, zelena – samo Boolova površina, modra – samo naselja, 
rumena – ploskev, kjer ni niti naselij niti Boolove ploskve) 
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3.3 Priprava orodij za izra čun kapa-testa neodvisnosti in prekrivanja 
slojev 
 
Pripravljeni sta bili dve novi orodji; orodje za izračun kapa-testa neodvisnosti in orodje 
za izračun prekrivanja med posameznimi podatkovnimi sloji. Obe orodji sta napisani v 
programskem jeziku Python, različice 2.5, ki je združljiv z ArcGIS-om (Tucker C., 
2004). Izdelani orodji delujeta po istem principu, razlikujeta se le v končnem izračunu. 
Orodji delujeta na podlagi števila (COUNT) in vrednosti (VALUE) rastrskih celic 
podatkovnega sloja, ki sta podani v atributni tabeli. Posamezne števke (VALUE) so v 
atributni tabeli povezane s številom rastrskih celic (COUNT), katerih vrednosti so 
vključene v izračun. Podatkovni sloj, na katerem se izvaja izračun kapa-testa ali 
prekrivanja, je pripravljen iz dveh binarnih slojev, zato vsebuje štiri vrednosti. Te 
vrednosti, ki so v obliki števil od 1 do 4, se vnesejo v polja parametrov zagona: Only 
First, Only Second, Both in None. 
 
Izpolnjevanje polj parametrov zagona za izračun prekrivanja dveh slojev ali izračuna 
ujemanja dveh slojev, na primer naselij s poplavnim območjem poteka po postopku: v 
polju Input Raster se izbere rastrski sloj, ki združuje sloj naselij s slojem poplavnih 
območij. Stolpec VALUE v atributni tabeli tega sloja vsebuje štiri vrednosti. Iz preostalih 
dveh stolpcev atributne tabele je razvidno, katera vrednost predstavlja določeno 
kombinacijo slojev poplavnega območja in naselij. V polju Only First se vnese številko, 
ki predstavlja samo naselja, v polje Only Second številko, ki predstavlja samo poplavna 
območja, v polje Both številko, ki predstavlja rastrske celice, ki so hkrati naselja in 
poplavno območje, v polje None pa številko, ki ne predstavlja niti poplavnega območja 
niti naselja. Ob potrditvi vnesenih vrednosti se izvedejo računske operacije. Rezultat 
izračuna orodja za prekrivanje posameznih slojev je v odstotkih izraženo prekrivanje 
sloja naselij s slojem poplavnega območja. V primeru računanja kapa-testa 
neodvisnosti je rezultat ujemanja med slojema prav tako izražen v odstotkih. 
 
Postopek za pisanje skripte: 
Python 2.5 -> IDLE (Python GUI) -> File -> New -> Prikaže se vmesnik za urejanje 
programske kode. 
File -> Save as -> izbere se končnico .py 
 
Pripravljeno orodje je bilo treba vključiti v aplikacijo ArcMap. Najprej sem ustvarila novo 
orodje, nato mu dodala skripto in določila tip in imena parametrov zagona, ki so vidni v 
uporabniškem vmesniku orodja. 
 
Postopek za dodajanje orodja (ArcMap): 
Klik z desnim gumbom miške na ozadje okna seznama orodij -> New Toolbox -> Add 
Script -> Desni klik miške na skripto. -> Properties -> Določi se imena in tip parametrov 
zagona. 
 
Obe orodji imata enaki imeni parametrov zagona: Input Raster, Only First, Only 
Second, Both in None. Za delovanje orodja je treba izpolniti polja vseh petih zahtevanih 
parametrov. Skripti za orodji sta prikazani v prilogi G in H, programski vmesnik za 
izračun kapa-testa prekrivanja je predstavljen v prilogi I. 
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3.4 Izdelava modelov v geografskem prostoru 
 
Izdelani so bili modeli za iskanje značilnosti leg naselij na Goričkem in Ravenskem. 
Modeli, deduktivna in induktivna modela za Goričko in Ravensko so bili izdelani v 
aplikaciji ModelBuilder, ki je sestavni del aplikacije ArcMap. Vhodni podatkovni sloji v 
vseh štirih modelih so povezani z orodjem Boolean And, vrednosti nebinarnih slojev pa 
so določene z orodji Greater Than Equal in Less Than Equal. Ker so modeli sestavljeni 
na enak način in se na prvi pogled med seboj ne razlikujejo, razen modela za 
Ravensko, ki imata en vhodni sloj manj, je v prilogi J prikazana sestava enega modela. 
 
Vhodni podatkovni sloji so sloj ekspozicije, naklona, vlažnosti površja in vetrovnosti. 
Induktivna in deduktivna modela se med seboj razlikujeta v vrednosti podatkovnih 
slojev, ki sestavljajo model. Modela za Ravensko se od modela za Goričko razlikujeta 
še po tem, da ne vključujeta sloja ekspozicije, saj jo je zaradi ravnega terena 
nesmiselno upoštevati. Ker me niso zanimale vrednosti ekspozicije, naklona, vlažnosti 
površja in vetrovnosti na celotnem testnem območju, temveč le območja, kjer 
pričakujemo naselja, sem območje Boolove površine modela umerila oziroma omejila 
na območja naselij iz leta 2009. Umerjanje modela se uporablja za zmanjšanje Boolove 
površine modela, z namenom zoženja te površine na območje, ki ga analiza obravnava 
(Clarke K. C. in Silva E. A., 2001). Za umerjanje modela sem izbrala sloj naselij iz leta 
2009, ker nobeno od naselij iz obravnavanih obdobij ne presega mej naselij iz leta 
2009. S tem sem dobila območje, kjer so naselja dejansko prisotna in znotraj katerega 
sem opazovala vrednosti podatkovnih slojev ekspozicije, naklona, vlažnosti površja in 
vetrovnosti, ter jih primerjala z lego naselij iz vseh obravnavanih obdobij. 
 
Postopek za izdelavo modela (ArcMap): 
Orodna vrstica Standard -> Start ModelBuilder -> Add Data or Tool -> Izbere se 
podatkovni sloj. -> Add Data or Tool -> Izbere se orodje, ki se ga poveže s prej 
izbranim podatkovnim slojem. -> Add Connection 
 
Po končanem sestavljanju modela je bil ta shranjen in pognan (ArcMap, aplikacija 
ModelBuilder): 
File -> Save -> Run 
 
3.4.1 Izdelava deduktivnega modela 
 
Za deduktivni model je značilno upoštevanje vrednosti, ki jih neodvisno od 
podatkovnega sloja, za katerega izdelujemo model, povzamemo iz literature ali jih 
določimo sami. V deduktivnem modelu sem upoštevala vrednosti vstopnih slojev 
ekspozicije in naklona, ki veljajo za večino naselij v Sloveniji (Perko D., 2001). Za 
primerne vrednosti so bila vključena južna, jugovzhodna in jugozahodna ekspozicija 
površja in naklon do vključno 12°. Za sloje vlažnosti in vetrovnosti sem izbra la 
najmanjše vrednosti, ker pričakujem, da se naselja nahajajo na manj vlažnih in 
zavetrnih legah. Pri deduktivnem modelu so za območje Goričkega in Ravenskega 
uporabljene enake vrednosti vhodnih podatkov modela. 
 
3.4.2 Izdelava induktivnega modela 
 
Za induktivni model je značilno upoštevanje vrednosti, značilnih za naselja iz leta 1850. 
Ker niso vsa naselja postavljena po istih načelih, sem se odločila upoštevati prostorske 
danosti, ki jih upošteva 95 % naselij na testnem območju Goričkega in Ravenskega. Z 
induktivnim modelom sem iskala prostorske značilnosti poselitev. Vhodni podatki 
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modela so izbrani tako, da upoštevajo vrednosti naklona, ekspozicije, vetrovnosti in 
vlažnosti, ki ustrezajo 95 % naselij iz leta 1850 na Goričkem in Ravenskem. Te 
vrednosti so bile določene s sistematskim iskanjem: posamezen podatkovni sloj je bil 
izdelan v binarni obliki pri različnih vrednostih, nato je bilo izračunano njegovo 
prekrivanje s slojem naselij. 
 
3.4.3 Izdelava orodja za iskanje območij 
 
V programskem jeziku Python, različice 2.6, sem izdelala orodje za iskanje območij, ki 
je pripravljeno v obliki modela, ki ga uporabnik lahko uporablja preko uporabniškega 
vmesnika, po vzoru ostalih orodij, ki so sestavni del aplikacije ArcMap. Orodje je bilo 
prvotno namenjeno iskanju območij, ki ustrezajo zahtevam uporabnikov za postavitev 
novogradenj, vendar se orodje lahko uporablja za iskanje kakršnih koli območij. 
Uporabniški vmesnik uporabniku omogoča izbiro do deset vhodnih podatkovnih slojev 
in določitev njihove vrednosti. To orodje je avtomatiziran deduktivni model, sestavljen iz 
vgrajenih orodij ArcMap-a: Bolean And, Less Than Equal in Great Than Equal. Prvo 
omogoča povezavo med posameznimi vstopnimi parametri, s preostalima dvema pa 
parametru določimo vrednost, ki naj jo orodje upošteva. Podatkovni sloji, ki vstopajo v 
orodje, morajo biti pripravljeni v rastrski obliki kot binomski sloji ali s podatki v zvezni 
obliki. Za delovanje orodja je pomembno, da imajo vhodni rastrski podatki atributno 
tabelo. Pri vsakem vhodnem rastru lahko izberemo stolpec atributne tabele, iz katere 
naj orodje prebere vrednost. Stolpec atributne tabele izberemo iz drsnega seznama, ki 
se pojavi po vnosu rastrskega podatka v polju Input Field. Poleg tega lahko določimo 
tudi vrednost podatka, za katerega želimo, da ga orodje upošteva. To določimo v poljih 
Min Value in Max Value. V zadnjem polju Output Raster določimo mesto, kamor naj se 
novonastali rastrski sloj shrani. Rezultat orodja je binarni rastrski podatkovni sloj, ki 
prikazuje območje glede na vstavljene kriterije. Prednost tega orodja v primerjavi z 
modelom, sestavljenim v aplikaciji ModelBuilder, je ta, da je model vnaprej pripravljen, 
saj je vanj treba vnesti le podatkovne sloje. Prav tako podatkov ni treba povezovati 
med seboj in jim določati mesta, kamor naj se shranijo, saj je to v orodju vnaprej 
določeno in zato nudi hitrejši postopek združevanja vstopnih podatkovnih slojev in 
preprostejši dostop do rezultata. 
 
Postopek za pisanje skripte: 
Pyhton 2.6 -> IDLE (Python GUI) -> File -> New -> Prikaže se vmesnik za urejanje 
programske kode. 
File -> Save as -> izbere se končnico .py 
 
Postopek za dodajanje orodja (ArcMap): 
Klik z desnim gumbom miške na ozadje okna seznama orodij -> New Toolbox -> Add 
Script -> Desni klik miške na skripto. -> Properties -> Določi se imena in tip parametrov 
zagona. 
 
Orodje vsebuje pet različnih parametrov zagona: Input Raster, Input Field, Min Value, 
Max Value in Output Raster. Polja Input Raster, Input Field, Min Value, Max Value se 
ponovijo desetkrat, saj orodje omogoča vnos deset vstopnih podatkovnih slojev. 
Skripta orodja in programski vmesnik sta prikazana v prilogi K in L. 
 
3.4.4 Priprava slojev za statistično analizo hipotez 
 
Sloji za statistično analizo hipotez so bili združeni po postopku, opisanem v razdelku 
3.2.17. Za analizo prve hipoteze so bili uporabljeni sloji naselij za leto 1850, ekspozicije 
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ter naklona površja in vetrovnosti ob predpostavki, da piha iz vseh glavnih osmih strani 
neba enako. Pri sloju ekspozicije so bile za sončne lege upoštevane južne ekspozicije 
od vzhoda do zahoda, pri sloju vetrovnosti so bile upoštevane zavetrne lege, pri sloju 
naklona pa vrednosti do 10°. Za analizo druge hipot eze sta bila uporabljena 
podatkovna sloja naselij za leto 1850 in sloj oddaljenosti od vod do vključno največ 500 
metrov. Za analizo zadnje hipoteze sta bila uporabljena sloja novogradenj za obdobje 
1971–2009 in sloj kmetijskih zemljišč za leto 1971. Sloj naselij iz leta 1850 je bil najprej 
združen s slojem ekspozicije, nato s slojem vetrovnosti, naklona, oddaljenosti od vod in 
kmetijskimi zemljišči. 
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4 REZULTATI IN RAZPRAVA 
 
Poglavje je razdeljeno na tri dele: prvi del obravnava rezultate izdelanih modelov in 
njihovo primerjavo z naselji iz leta 1850 in novogradnjami iz obdobij 1850–1890, 1890–
1940, 1940–1971 in 1971–2009. Drugi del opisuje značilnosti leg naselij in novogradnje 
iz obravnavanih obdobij glede na prostorske značilnosti. V tretjem delu so 
predstavljene spremembe pokrajine od leta 1850 do leta 2009. 
 
4.1 Rezultati modelov 
 
Rezultat modela je binarni rastrski podatkovni sloj s prikazanimi območji, ki ustrezajo 
(Boolova ploskev) in ne ustrezajo zahtevanim vstopnim parametrom modela. Način, po 
katerem so bile določene vrednosti vhodnih podatkov modelov, je pojasnjen v razdelkih 
3.4.1 in 3.4.2. Vhodni podatkovni sloji modelov so bili med seboj primerjani s kapa-
testom neodvisnosti (razdelek 3.3). 
 
4.1.1 Kapa-test neodvisnosti 
 
S kapa-testom neodvisnosti sem ugotavljala medsebojno odvisnost vhodnih slojev 
modelov in njihovo odvisnost z rezultati modelov. Rezultati izračuna kapa-testa so 
podani v prilogi M. Pri kapa-testu velja, da manjši, kot je odstotek rezultata kapa-testa, 
manjše je ujemanje med podatkoma. Pri negativnih rezultatih kapa-testa ujemanja med 
podatkoma ni. V primeru, da bi bil rezultat kapa-testa velik, bi to pomenilo, da sta sloja 
med seboj odvisna in pokrivata večinoma enako območje. S preverjanjem vhodnih 
podatkovnih slojev z rezultatom modela sem se prepričala, da rezultat modela ni 
podrejen le enemu vhodnemu podatkovnemu sloju. Izračun je pokazal, da se vhodni 
podatkovni sloji med seboj zelo malo ujemajo. Največje ujemanje je bilo izračunano 
med rezultati modelov in slojem naselij iz leta 2009, kar je bilo pričakovano, saj je ta 
sloj služil za umerjanje rezultata modela. 
 
4.1.2 Rezultati deduktivnega modela 
 
Z deduktivnim modelom sem ugotavljala, v kolikšni meri naselja iz leta 1850 in 
novogradnje iz ostalih obravnavanih obdobij upoštevajo prostorske značilnosti, 
določene deloma iz literature deloma iz lastnih pričakovanj. Sloj rezultata deduktivnega 
modela je bil primerjan (prekrit) s sloji naselij iz leta 1850 in s sloji novogradenj iz 
obdobij 1850–1890, 1890–1940, 1940–1971 in 1971–2009 za Goričko in Ravensko. Z 
umerjanjem modela sem razmerje med Boolovo ploskvijo in površino območja močno 
zmanjšala, saj je pred umerjanjem predstavljala 25 % območja Goričkega (slika 20) in 
40 % Ravenskega (slika 21), po umerjanju pa manj kot odstotek območja Goričkega in 
manj kot odstotek območja Ravenskega. Pred umerjanjem modela je bila Boolova 
ploskev modela 30-krat večja od naselij iz leta 1850 na Goričkem in 20-krat večja od 
naselij iz leta 1850 na Ravenskem. Po umerjanju je bilo to razmerje na Goričkem 
skoraj 2,5 in na Ravenskem nekoliko manjše od 2. 
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Slika 20:  Boolova ploskev (modra) deduktivnega modela za Goričko pred 
vrednotenjem (levo) in po vrednotenju (desno) modela, prekrita s slojem naselij (rdeča) 

iz leta 1850 
 

 
 

Slika 21:  Boolova ploskev (modra) deduktivnega modela za Ravensko pred 
vrednotenjem (levo) in po vrednotenju (desno) modela, prekrita s slojem naselij (rdeča) 

iz leta 1850 (detajl) 
 
Iz slike 22 je razvidno, da na Goričkem bistveno manjši delež (31 %) naselij iz leta 
1850 v primerjavi z Ravenskim (76 %) upošteva vrednosti naklona pod 15°, lege 
zahodne, južne in vzhodne ekspozicije ter območij z najmanjšo vetrovnostjo in 
vlažnostjo tal. Razlog je najverjetneje v ekspoziciji, saj je v modelu za Ravensko nisem 
upoštevala, poleg tega pa kar 14 % naselij iz leta 1850 leži na severozahodnih 
ekspozicijah, manjši delež tudi na severovzhodni in severni ekspoziciji. Na Ravenskem 
je ujemanje z navedenimi vrednostmi večje kot na Goričkem. Za obe območji se kaže 
trend upadanja ujemanja Boolove površine modela od najstarejših proti novejšim letom 
z naselji oziroma novogradnjami, kar kaže ne neupoštevanje določenih vrednosti 
parametrov modela. Izstopata le obdobje 1940–1971 oziroma obdobje 1890–1940 in 
1940–1971 na Goričkem in obdobje 1890–1940 na Ravenskem, z nekoliko povečanim 
ujemanjem novogradenj z Boolovo površino. Obstaja verjetnost, da rezultat odstopa za 
obdobji 1890–1940 in 1940–1971, ker je podatkovni sloj novogradenj manjšega 
obsega od ostalih slojev. 
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Slika 22:  Delež ujemanja naselij iz leta 1850 in novogradenj iz ostalih obravnavanih 
obdobij z Boolovo površino deduktivnega modela za Goričko in Ravensko 

 
4.1.3 Rezultati induktivnega modela 
 
Z induktivnim modelom sem ugotavljala, v kolikšni meri novogradnje iz obravnavanih 
obdobij upoštevajo enake prostorske značilnosti, kot naselja iz leta 1850. S tem 
namenom sem poiskala vrednosti vhodnih podatkovnih slojev, ki jih upošteva večina 
naselij iz leta 1850, jih vstavila v model ter rezultat modela primerjala (prekrila) s sloji 
novogradenj iz obdobij 1850–1890, 1890–1940, 1940–1971 in 1971–2009 za Goričko 
in Ravensko. Z umerjanjem modela sem razmerje med Boolovo površino in površino 
območja močno zmanjšala, saj je pred umerjanjem predstavljala 62 % območja 
Goričkega (slika 23) in 73 % Ravenskega (slika 24), po umerjanju pa 2 % območja 
Goričkega in 4 % območja Ravenskega. Pred umerjanjem modela je bila Boolova 
površina modela kar 77-krat večja od naselij iz leta 1850 na Goričkem in 37-krat večja 
od naselij iz leta 1850 na Ravenskem. Po umerjanju je bilo to razmerje na Goričkem 
skoraj 1,5 in na Ravenskem nekoliko manjše od 2. 
 

 
 

Slika 23:  Boolova površina (modra) induktivnega modela za Goričko pred 
vrednotenjem (levo) in po vrednotenju (desno) modela, prekrita s slojem naselij (rdeča) 

iz leta 1850 
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Slika 24:  Boolova površina (modra) induktivnega modela za Ravensko pred 
vrednotenjem (levo) in po vrednotenju (desno) modela, prekrita s slojem naselij (rdeča) 

iz leta 1850 
 
Z izračunom prekrivanja Boolove površine z naselji iz leta 1850 in novogradnjami iz 
preostalih obravnavanih obdobij sem ugotovila (Slika 25), da 80 % naselij iz leta 1850 
na Goričkem in 85 % naselij na Ravenskem iz leta 1850 ustreza Boolovi površini 
modela. Na Goričkem se nato ta delež zmanjšuje vse do leta 2009, kar pomeni, da vse 
manjši delež novogradenj upošteva enake okoljske pogoje kot naselja leta 1850. Na 
Ravenskem je rezultat povsem drugačen: do leta 1940 se odstotek manjša, v obdobju 
1940–1971 sunkovito narase, nakar se v obdobju 1971–2009 znova spusti, a je še 
vedno višji od obdobij 1850–1890 in 1890–1940. Odstopanje rezultata za obdobje 
1940–1971 je najverjetneje posledica manjšega obsega sloja novogradenj za to 
obdobje. Presenetljiv je odstotek ujemanja novogradenj iz obdobja 1971–2009, iz česar 
sklepam, da novogradnje iz tega obdobja upoštevajo podobne značilnosti prostora, kot 
naselja iz leta 1850 in celo bolj od novogradenj iz obdobij 1850–1890 in 1890–1940. 
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Slika 25:  Delež ujemanja naselij iz leta 1850 in novogradnjami iz drugih obravnavanih 
obdobij z Boolovo ploskvijo induktivnega modela za Goričko in Ravensko 

 
4.1.4 Rezultat orodja za iskanje območij 
 
Orodje je bilo zamišljeno za iskanje območij, ki ustrezajo zahtevam uporabnikov za 
postavitev novogradenj, vendar se lahko uporablja za iskanje kakršnih koli območij. 
Kakšno območje uporabnik želi za rezultat, je odvisno od vrednosti vhodnih 
podatkovnih slojev. Kot primer uporabe orodja za iskanje območij sem v programski 
vmesnik vstavila podatkovne sloje, ki predstavljajo naravne in ustvarjene prostorske 
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danosti, s katerimi sem želela poiskati primerna območja za novogradnje. V polja Input 
Raster sem vnesla podatkovne sloje naklona, ekspozicije, območje katastrofalnih 
poplav ter območja oddaljenosti od telekomunikacijskega in cestnega omrežja. V polju 
Input Field sem izbrala stolpec atributne tabele, iz katere naj orodje bere vrednosti. V 
poljih MinValue in MaxValue sem izbrala vrednosti, ki naj jih model upošteva kot 
pravilne za zvezne podatkovne sloje (naklon in ekspozicija). Pri binarnih podatkovnih 
slojih teh polj ni treba izpolniti. V polje Output Raster sem vnesla podatek, kamor naj se 
izdelan binarni sloj shrani. Ker je iskanje območij za novogradnje obsežen postopek, v 
katerega bi bilo potrebno vključiti še druge podatkovne sloje, se na tem mestu ne bom 
spuščala v primernost izbranih slojev. Slika 26 prikazuje rezultat orodja za izbrane 
vhodne podatke. Boolova ploskev orodja prikazuje območje, oddaljeno do 
vključno 100 m od cest, ki hkrati ustrezajo oddaljenosti do vključno 500 m od 
telekomunikacijskega in električnega omrežja, zahodni, južni in vzhodni ekspoziciji, 
površju z naklonom, manjšim od 15°, in obmo čjem, ki niso ogrožena zaradi 
katastrofalnih poplav. Z orodjem za iskanje območij bi lahko izdelala tudi modele 
(deduktivni in induktivni), ki sem jih izdelala z orodjem ModelBuilder. Ker pa je to orodje 
sestavni del aplikacije ArcMap, sem prikazala izdelavo modela na oba načina: z 
orodjem, ki sem ga imenovala Orodje za iskanje območij in z orodjem Model Builder. 
 

 
 

Slika 26:  Primer rezultata (Boolova površina je zelena) orodja za iskanje območja, 
oddaljenega od cest do vključno 100 m, od telekomunikacijskega in električnega 

omrežja do vključno 500 m, vzhodni, zahodni in južni ekspoziciji, površju z naklonom 
do vključno 15° in obmo čju, ki ni ogroženo zaradi katastrofalnih poplav 

 
4.2 Značilnosti leg naselij 
 
Značilnosti leg naselij so bile ugotovljene z združevanjem (razdelek 3.2.17) slojev 
naselij s sloji ekspozicije površja, naklona, ukrivljenosti površja, vetrovnosti, vlažnosti 
tal in oddaljenosti od vod. Značilnosti poselitev so podane kot delež naselij, ki ustreza 
določenim vrednostim ekspozicije površja, naklona, vetrovnosti in oddaljenosti od vod. 
Deleži so bili izračunani z orodjem za izračun prekrivanja slojev (razdelek 3.3). Pri 
predstavitvi značilnosti naselij so za leto 1850 upoštevana celotna naselja, za ostala 
obdobja pa le novogradnje. 
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Naselja iz leta 1850 predstavljajo 0,8 % območja Goričkega in 2 % območja 
Ravenskega (slika 27). Tudi delež novogradenj je na Goričkem manjši kot na 
Ravenskem. Pri obeh je prisoten trend večanja novogradenj v obdobju 1890–1940, le 
da je ta na Ravenskem še bolj izrazit v obdobju 1940–1971. Predvidevam, da je porast 
odstotka novogradenj povezan z gradnjo tovarn in drugih javnih ustanov v Murski 
Soboti in njeni okolici v teh obdobjih (Kuzmič F.). 
 

2

0,6

1

0,5

0,8

0,4

0,8
0,9

0,4
0,3

0

0,5

1

1,5

2

2,5

Goričko Ravensko

Območje

D
el

ež
 n

as
el

ij 
(%

)

1850

1890

1940

1971

2009

 
 

Slika 27:  Delež naselij iz leta 1850 in novogradenj v letih 1890, 1940, 1971 in 2009 na 
Goričkem glede na območje Goričkega in Ravenskega 

 
4.2.1 Ekspozicije površja 
 
Na območju Ravenskega so na sloju ekspozicije vidne napake, ki so posledica napak 
na uporabljenem DMR-ju. Zaradi tega je bil ta sloj uporabljen le za območje Goričkega. 
Poleg tega je na Ravenskem nesmiselno uporabljati sloj ekspozicije, saj je relief tam 
skoraj povsem raven. Na območju Goričkega so prisotne ekspozicije vseh glavnih 
osmih smeri neba, od katerih je najbolj (18 %) zastopana zahodna ekspozicija, sledita ji 
vzhodna (17 %) in jugovzhodna (16 %) ekspozicija, najmanj zastopani pa sta 
severovzhodna in severna ekspozicija (slika 28). 
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Slika 28: Delež smeri ekspozicije na Goričkem 
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Iz prekrivanja slojev naselij s slojem ekspozicije sem ugotovila, da se leta 1850 največ 
naselij nahaja na zahodni (18 %) ekspoziciji (slika 29), sledi jugovzhodna (17 %), nato 
pa jugozahodna (14 %), vzhodna (14 %) in severozahodna (14 %) ekspozicija. Leta 
1850 je najmanj naselij na severovzhodni (4 %) in severni (4 %) ekspoziciji. Najmanjši 
odstotek naselij na severni in severovzhodni ekspoziciji je pričakovan, saj je tudi delež 
ekspozicije s takšno smerjo najmanj zastopan. Odstotek naselij na severozahodu je 
nekoliko presenetljiv, ker sem pričakovala najmanjše deleže naselij na severnih 
ekspozicijah. V vseh obdobjih je najmanjši odstotek novogradenj na severni in 
severovzhodni ekspoziciji, ter največji na vzhodni, jugovzhodni in zahodni ekspoziciji. 
Delež novogradenj je manjši na južni in jugozahodni ekspoziciji, kot na vzhodni, 
jugovzhodni in zahodni ekspoziciji. Delež novogradenj se spreminja tudi po obdobjih. 
Če pogledamo severno ekspozicijo, vidimo, da je bilo najmanj novogradenj v obdobju 
1940–1971. Na severovzhodnih ekspozicijah je prav nasprotno; največ novogradenj je 
bilo v obdobju 1940–1971 in najmanj v obdobju 1971–2009. Na vzhodnih legah se je 
največ novogradenj pojavilo v obdobju 1890–1940. Jugovzhodna ekspozicija ima 
nasploh velik delež novogradenj, največ pa jih je bilo zabeleženih v obdobju 1890–
1971. Na južni ekspoziciji izstopa delež novogradenj v obdobju 1971–2009. Zahodna 
ekspozicija ima vse od leta 1890 do leta 2009 približno enak delež novogradnje, razlika 
med največjim in najmanjšim deležem novogradenj na tej ekspoziciji pa znaša le 2 %. 
Na severozahodni ekspoziciji od leta 1890 do leta 1971 ni večjih sprememb v deležu 
novogradenj, izstopa pa leto 2009, ki ima kar enkrat večji delež novogradenj od ostalih 
obdobij. Odstotki novogradenj sovpadajo z odstotki naselij glede na ekspozicijo 
površja, saj sta pri obeh najbolj zastopani ekspoziciji jugovzhoda in zahoda. 
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Slika 29:  Delež naselij iz leta 1850 in novogradenj v letih 1890, 1940, 1971 in 2009 na 

Goričkem glede na ekspozicijo površja 
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4.2.2 Naklon površja 
 
Območje Goričkega je razgibano gričevje, tudi z nakloni, večjimi od 15°. Deleža površja 
z naklonom do 5° in površja z naklonom 6°–10° sta n a Goričkem skoraj enakovredno 
zastopana (38 % in 37 %), medtem ko je površja z večjim naklonom manj (slika 30). 
Površja z naklonom 11°–15° je 20 % in z naklonom na d 15° 5 %. Na Ravenskem 
prevladuje površje z naklonom do 5°, površje z ve čjim naklonom se nahaja le na 
vznožju Goričkega. 
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Slika 30:  Razporeditev vrednosti naklona na testnem območju Goričkega in 
Ravenskega 

 
Leta 1850 je bilo na Goričkem 57 % naselij na naklonu do vključno 5° in 94 % do 
vključno 10° (slika 31). Nobeno naselje ni presegalo nakl ona 15°. Najve č novogradenj 
na Goričkem je bilo v vseh obravnavanih obdobjih postavljenih na terenu z vključno do 
5° naklona in najmanj na terenu z ve č kot 15° naklona, saj je naklon do 5° najbolj, 
naklon nad 15° pa najmanj zastopan. Na površju z do  5° naklona je bilo najve č 
novogradenj leta 1971, najmanj pa leta 1940 in 2009, iz česar sklepam in je tudi 
razvidno iz slike, da je bilo v teh obdobjih več novogradenj na površju z večjim 
naklonom. Na površju z naklonom 6°–10° je bilo v vs eh obravnavanih obdobjih 
postavljenih manj novogradenj kot na naklonu do 5°.  Najbolj izstopa odstotek 
novogradenj iz obdobja 1890–1940. Na pobočju z naklonom 11°–15° se nahajajo 
novogradnje v vseh obdobjih, od katerih ima največji odstotek obdobje 1971–2009. 
Najmanj novogradenj so na tem območju postavili v obdobju 1940–1971. Tudi na 
pobočjih z večjim naklonom od 15° se v obdobjih 1890–1940, 1940–1 971 in 1971–
2009 pojavi 1 % novogradenj. 
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Slika 31:  Delež naselij iz leta 1850 in novogradenj v letih 1890, 1940, 1971 in 2009 na 
Goričkem glede na naklon površja 

 
Slika 32 prikazuje postavitev naselij na Goričkem glede na naklon površja. V Vadarcih 
so stavbe na vrhu slemena, na robu doline in na pobočju, vendar vse na položnejših 
delih. Novogradnje iz obdobja 1971–2009 v naselju Grad so deloma postavljene na 
površje z majhnim naklonom, deloma na površje z večjim naklonom. 
 

 
 

Slika 32:  Lega dela naselja (rdeča) Vadarci (levo) leta 1850 in novogradnja (rdeča) v 
Gradu (desno) iz obdobja 1971–2009 glede na manjši (temno rjava) in večji (svetlo 

rjava) naklon 
 
Na Ravenskem so bila 1850 leta vsa naselja na ravnini z do 5° naklona. Ve čina 
novogradenj iz vseh obdobij se nahaja na terenu z do vključno 5° naklona (slika 33), 
saj je ta na Ravenskem najbolj (9 %) zastopan (slika 30). Odstotek novogradenj se v 
primerjavi z letom 1850 v preostalih obdobjih najprej zmanjša in se nato zopet 
povečuje. V nasprotju s tem se v obdobju 1850–1890 odstotek novogradenj z 
naklonom 6°–10°pove ča in nato pade. 
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Slika 33:  Odstotek novogradenj na Ravenskem po naklonu površja 
 
Na sliki 34 sta prikazani naselji Gorica in Puconci, ki sta postavljeni ob vznožje 
Goričkega, kjer se nagib terena poveča. Leta 1850 sta naselji postavljeni na ravnini, tik 
pod in nad pobočjem. Čeprav se zdi, da del Puconcev leži na površju z večjim 
nagibom, je pravzaprav postavljeno tik pod pobočje, tja, kjer se naklon izravna. Del 
novogradnje v Brezovcih iz obdobja 1850–1890 se vzpenja po strmejšem pobočju, 
večina pa je na položnejšem površju. 
 

 
 

Slika 34:  Lega naselij (rdeča) Gorica in Puconci (levo) leta 1850 in novogradnje 
(rdeča) v Brezovcih iz obdobja 1850–1890 glede na manjši (temno rjava) in večji 

(svetlo rjava) naklon 
 
4.2.3 Vetrovnost 
 
Na območju Goričkega je 23 % območja izpostavljeno najmočnejšemu vetru, medtem 
ko se na Ravenskem pojavljajo šibkejši vetrovi kot na Goričkem. Postavitev naselij 
glede na vetrovnost, ob predpostavki, da piha iz vseh smeri enako, pokaže, da je leta 
1850 na Goričkem 29 % naselij (slika 35) na vetrovno najbolj izpostavljenih legah. 
Največji odstotek novogradenj na teh območjih je v obdobju 1850–1890, najmanjši pa v 
obdobju 1940–1971. Povprečna vrednost hitrosti vetra za leto 2009 na Goričkem znaša 
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od 1,8 do 3,8 m/s, kar ne predstavlja močnega vetra, zato je verjetno, da se pri gradnji 
naselij niso kaj dosti ozirali na veter. 
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Slika 35: Delež naselij iz leta 1850 in novogradenj v letih 1890, 1940, 1971 in 2009 na 
vetrovno najbolj izpostavljenih območjih na Goričkem 

 
Na sliki 36 sta prikazani naselji Šalamenci in zahodni del naselja Vaneča, ki se med 
seboj zelo razlikujeta po postavitvi. Šalamenci so v zavetrju, postavljeni so pod rob, 
medtem ko Vaneča leži na vrhu vzpetine na vetrovno izpostavljenih slemenih in tudi 
pod vzpetino, kjer je bolj zavetrno. Naselji sta primer lege naselja na vetrovno 
zavetrnem in izpostavljenem območju na majhni razdalji. Desna slika prikazuje 
novogradnje iz obdobja 1850–1890 na Kranjčevem bregu, ki leži na vetrovno najbolj 
izpostavljenih območjih, pa tudi v dolinah, ki so najbolj zavetrne. 
 

 
 
Slika 36:  Lega Šalamencev in Vaneče (rdeča) leta 1850 (levo) in novogradnje (rdeča) 
na Kranjčevem Bregu iz obdobja 1850–1890 (desno) glede na manjšo (temno siva) in 

večjo (svetlo siva) vetrovnost 
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4.2.4 Oddaljenost od vodotokov 
 
Na Goričkem je bilo leta 1850 31 % naselij oddaljenih od vod za največ 200 m, 55 % za 
največ 300 m, 74 % za največ 400 m in 81 % za največ 500 m (slika 37). Iz rezultatov 
je razvidna povezava med legami naselij in oddaljenostjo od vode, iz česar sklepam, 
da je bila bližina vodotokov merilo za postavitev naselij, kar navaja tudi Urbanc M. 
(2002). Na Ravenskem je stanje nekoliko drugačno: 33 % naselij je oddaljenih od vod 
za največ 200 m, 44 % za največ 300 m, 48 % za največ 400 m in 54 % za največ 
500 m. Odstotek naselij do 200 m od vodotokov je skoraj enak na Goričkem in 
Ravenskem, na večjih oddaljenostih pa je manj naselij kot na Goričkem. Razlog za 
takšno postavitev naselij glede na oddaljenost od potokov sta prav gotovo visoka 
podtalnica (Repe B., 2009) na prekmurski ravnini, ki nudi dostop do vode, in lažja 
prehodnost ravninskega terena, zaradi česar je razdalja manj pomembna. Na 
Ravenskem so majhne globine do gladine podzemnih vod, saj se srednje globine do 
gladine podtalnice na večini vodomernih postaj v Prekmurju gibljejo od 1 do 5 m 
(Brečko Grubar V., 2009). 
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Slika 37:  Odstotek območja Goričkega in Ravenskega, ki je leta 1850 oddaljen od 
vodotokov od 200 m do 500 m 

 
Na sliki 38 je prikazana postavitev naselij v letu 1850 na Goričkem glede na 
oddaljenost od vodotokov. Naselji Kovačevci in Prosečka Vas sta večinoma oddaljeni 
do 200 m od vodotokov, medtem ko se del Moščancev nahaja tudi dlje od 500 m od 
vodotokov. Naselji Kovačevci in Prosečka vas sta primer naselij, ki ležijo v bližini 
vodotokov, Moščanci pa predstavljajo naselje, ki je le deloma postavljeno v bližino 
vodotokov. 
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Slika 38:  Lega naselij (rdeča) Kovačevci in Prosečka Vas leta 1850 (levo) in Moščanci 
glede na oddaljenost od vodotokov (svetlo oranžna – 200 m, temno oranžna – 300 m, 

rdeča – 400 m, vijolična – 500 m) 
 
Na sliki 39 so prikazana naselja Zgornji in Spodnji Strukovci ter Markišavci. Zgornji in 
Spodnji Strukovci so deloma znotraj območja do 500 m oddaljenosti od vodotoka, 
medtem ko Markišavci v celoti ležijo zunaj tega območja. 
 

 
 

Slika 39:  Lega naselij (rdeča) Zg. in Sp. Strukovci leta 1850 (levo) in Markišavci glede 
na oddaljenost od vodotokov (svetlo oranžna – 200 m, temno oranžna – 300 m, rdeča 

– 400 m, vijolična – 500 m) 
 
4.2.5 Naselja na poplavnem območju 
 
Poplavno območje katastrofalnih poplav pokriva 2 % območja Goričkega in 6 % 
območja Ravenskega. Na Goričkem poplavljajo potoki Lukaj, Spunika in Bezjak, ki sta 
pritoka Bodonskega potoka, ter Bodonski potok, medtem ko na območju Ravenskega 
poplavljajo potoki Dobel, Puconski potok in Sebeborski potok. 
 
Leta 1850 območje katastrofalnih poplav ni poseljeno. V obdobjih 1850–1890, 1890–
1940 in 1940–1971 se pojavi 1 % novogradenj na poplavnem območju na Goričkem 
(slika 40). V obdobju 1971–2009 se povzpne na 3 %. Na Ravenskem se pojavi 1 % 
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novogradenj na poplavnem območju v obdobjih 1890–1940 in 1971–2009. Glede na to, 
da že leta 1850 območje katastrofalnih poplav ni poseljeno, obstaja verjetnost, da je že 
takrat tam bilo poplavno območje. 
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Slika 40:  Delež naselij iz leta 1850 in novogradenj v letih 1890, 1940, 1971 in 2009 na 

območju katastrofalnih poplav na Goričkem in Ravenskem 
 
Kljub temu, da je podatkovni sloj poplavnega območja iz leta 2007, naselje Motovilci že 
leta 1850 leži ob njegovem robu, iz česar sklepam, da je potok Lukaj poplavljal že 
takrat. Naselje Motovilci se je širilo na poplavno območje v vseh obdobjih (slika 41). 
 

 
 
Slika 41:  Lega Motovilcev (rdeča) leta 1850 (levo) in novogradnje (rdeča) v Motovilcih 

iz obdobja 1971–2009 glede na poplavno območje (modra) 
 
Tudi na Ravenskem so naselja iz leta 1850 odmaknjena iz poplavnih območij (slika 
42). Leva slika prikazuje razporeditev naselij okoli poplavnega območja Puconskega 
potoka. Zahodno od poplavnega območja Puconskega potoka sta naselji Polana in 
Predanovci, severno sta Gorica in Puconci ter vzhodno Markišavci in Nemčavci. 
Novogradnja iz obdobja 1971–2009 v naselju Puževci deloma sega na poplavno 
območje Bodonskega potoka. Na robu testnega območja je manjši del poplavnega 
območja Sebeborskega potoka, v katerem se nahaja novogradnja iz obdobja 1890–
1940. 
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Slika 42:  Lega naselij (rdeča) v okolici poplavnega območja Puconskega potoka leta 
1850 (levo) in novogradnje (rdeča) v naselju Puževci iz obdobja 1971–2009 glede na 

poplavno območje (modra) 
 
4.2.6 Naselja in vlažnost tal 
 
Območja z največjo vrednostjo vlažnosti predstavljajo 3 % območja Goričkega in 26 % 
območja Ravenskega. Vlažnost tal na Ravenskem in v dolinah Goričkega potrjuje tudi 
dejstvo, da tam uspevajo vlagoljubne rastlinske vrste (Repe B., 2009). Na najbolj 
vlažnih tleh v letu 1850 na Goričkem ni bilo naselij, na Ravenskem pa je bilo takšnih 
7 % (slika 43). Od leta 1850 do leta 2009 so se naselja širila tudi v vlažnejša območja. 
Največji odstotek novogradenj na vlažnih območjih se pojavi na Goričkem (7 %) in 
Ravenskem (19 %) v obdobju 1971–2009. Najmanjši delež naselij na najbolj vlažnih 
tleh je na Goričkem po pričakovanjih leta 1850, na Ravenskem (3 %) pa v obdobju 
1890–1940, kar je v nasprotju s pričakovanji. Glede na to, da ta odstotek močno 
odstopa od ostalih obdobij, je možno, da gre za napako, ker sloj novogradenj za to 
obdobje ne pokriva celotnega dela Ravenskega. 
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Slika 43:  Novogradnje na najbolj vlažnih tleh za Goričko in Ravensko 
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Slika 44 prikazuje postavitev naselij glede na vlažnost tal na Goričkem. Naselje 
Zenkovci leži na meji med Goričkim in Ravenskim, severni del naselja je višje kot južni 
del, zato je na območju Goričkega. Južni del naselja, ki je na nižji nadmorski višini, 
pade na poplavno območje Bodonskega potoka, severnejši del pa ne. Prav tako je 
severni del naselja na območju z manjšo vlažnostjo kot južni del naselja. V naselju 
Pečarovci je večina novogradenj na območju z visoko vlažnostjo, nekaj pa tudi na 
območju z nizko vlažnostjo. 
 

 
 

Slika 44:  Lega dela naselja Zenkovci (rdeča) leta 1850 in novogradnje (rdeča) v 
Pečarovcih iz obdobja 1971–2009 glede na manj (temno siva) in bolj (svetlo siva) 

vlažna tla 
 
Ravensko je na splošno veliko bolj vlažno od Goričkega (slika v prilogi D), zato so 
povezave med postavitvijo naselij in vlažnostjo tal slabše vidne (slika 45). Naselje 
Borejci se nahaja na južnem robu testnega območja. Zanimivo je, da je vlažnost tal v 
okolici Borejcev največja, Borejci pa so postavljeni na območje, kjer je vlažnost 
nekoliko manjša. Novogradnje naselij Polana in Predanovci ne upoštevajo vlažnosti tal. 

 

 
 

Slika 45:  Lega Borejcev (rdeča) leta 1850 (levo) in novogradnje (rdeča) v Polani in 
Predanovcih iz obdobja 1971–2009 (desno) glede na manj (temno siva) in bolj (svetlo 

siva) vlažna tla 
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4.2.7 Ukrivljenost površja in postavitev naselij 
 
Pri ukrivljenosti površja sem se osredotočila na konkavno in konveksno ukrivljenost 
površja. Konkavno ukrivljeno površje predstavlja doline, konveksno ukrivljeno površje 
pa slemena. Na Goričkem sta obe obliki ukrivljenosti zastopani v skoraj enaki meri: 
konkavnega površja je 27 %, konveksnega pa 28 %. Primerjava lege naselij z 
ukrivljenostjo terena je pokazala (slika 46), da se več naselij nahaja na konveksno 
ukrivljenem, kot pa na konkavno ukrivljenem površju, ter da se odstotek naselij na 
konveksno ukrivljenem površju z leti zmanjšuje v prid konkavno ukrivljenemu. Odstotek 
novogradnje za obdobje 1940–1971 nekoliko odstopa, čemur je morda vzrok po 
površini manjši sloj novogradenj za to obdobje ali širjenje naselij na ravnem površju. 
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Slika 46:  Delež naselij iz leta 1850 in novogradenj v letih 1890, 1940, 1971 in 2009 na 
konveksno in konkavno ukrivljenem površju 

 
Na sliki 47 so prikazana naselja Varaš, Šalamenci in Pečarovci leta 1850 ter 
novogradnje v obdobju 1971–2009 v Prosečki Vasi. Varaš in Šalamenci so postavljeni 
na ravnih površinah, medtem ko je večji del Pečarovci na vrhu slemena, kjer je površje 
konveksno ukrivljeno. Šalamenci ležijo, podobno kot Varaš, pod pobočjem. Površja s 
konkavno ukrivljenostjo niso naseljena. Novogradnje v Prosečki Vasi se nahajajo na 
ravnem in tudi na konkavno ukrivljenem površju, kar je v nasprotju s postavitvijo naselij 
na levi sliki. 
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Slika 47:  Lega naselij (rdeča) Varaš, Pečarovci in Šalamenci leta 1850 (levo) in 
novogradnje (rdeča) v Prosečki Vasi iz obdobja 1971–2009 glede na konkavno (rjava) 

in konveksno (modra) ukrivljenost površja 
 
4.2.8 Širitev naselij na kmetijska zemljišča 
 
Največji delež kmetijskih zemljišč na Goričkem je leta 1850 (59 %) in vse od takrat do 
leta 2009 pada (slika 48). Na Ravenskem je delež kmetijskih zemljišč približno enak od 
leta 1850 vse do leta 2009, nekoliko pa izstopa (78 %) le v obdobju 1850–1890. Delež 
novogradenj na kmetijskih zemljiščih na Goričkem je največji v obdobju 1850–1890 in 
najmanjši v obdobju 1940–1971. Razlog za odstopanje novogradenj v obdobju 1940–
1971 je morda širitev naselij na gozdne in ne kmetijske površine ali pa po površini 
nekoliko manjši sloj novogradenj za to obdobje. Nasprotno od Goričkega je na 
Ravenskem največji odstotek novogradenj na kmetijskih zemljiščih v obdobju 1940–
1971 in najmanjši v obdobju 1890–1940 in 1971–2009. Sprememba zaraščenih 
zemljišč v kmetijske pridelovalne površine je z ustreznimi posegi možna in smiselna, 
medtem ko je sprememba urbaniziranih območij v kmetijske površine neuresničljiva 
(Marušič J., 1989). 
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Slika 48:  Delež novogradenj na kmetijskih zemljiščih na Goričkem in Ravenskem 
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Na sliki 49 so na levi sliki prikazane novogradnje iz obdobja 1850–1890 v Beznovcih in 
Zenkovcih na sloju kmetijskih zemljišč iz leta 1850. Desna slika prikazuje novogradnje 
v obdobju 1940–1971 v Belem Križu na sloju gozdnih in kmetijskih površin iz leta 1940. 
V Beznovcih in Zenkovcih se novogradnje v prikazanih obdobjih pojavljajo le na 
kmetijskih zemljiščih, v Belem Križu pa tudi na gozdnih površinah. 
 

 
 

Slika 49:  Lega novogradenj (rdeča) v Beznovcih in Zenkovcih iz obdobja 1850–1890 
(levo) in novogradnje (rdeča) v Belem Križu iz obdobja 1940–1971 (desno) glede na 

kmetijsko (rjava) in gozdno (zelena) površino 
 
Na sliki 50 so prikazane novogradnje na kmetijskih zemljiščih na Ravenskem v Lemerju 
in Krajini ter Gederovcih. Desna slika prikazuje širjenje obcestnega naselja Lemerje v 
kmetijska zemljišča, ki naselje obdajajo. Na levi sliki so prikazane novogradnje, 
zgrajene na kmetijskem zemljišču obcestnega naselja Krajna in gručastega naselja 
Gederovci, ki so bile zgrajene na kmetijskem zemljišču. 
 

 
 

Slika 50:  Lega novogradenj (rdeča) v Lemerju iz obdobja 1940–1971 (levo) in 
novogradnje (rdeča) v Krajni in Gederovcih iz obdobja 1971–2009 (desno) glede na 

kmetijsko (rjava) površino 
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4.3 Spremembe pokrajine 
 
Spremembe pokrajine so bile ugotovljene iz podatkovnih slojev rabe tal na Goričkem in 
Ravenskem. Spremembe v zastopanosti in razširjenosti posameznih kategorij so vidne 
na celotnem testnem območju. Pri obravnavanju vseh sprememb je treba imeti pred 
očmi, da so te v prvi vrsti odsev družbenogospodarskih dogajanj in šele nato 
prostorskih potencialov (Ogrin D., 2010). Opazne so spremembe naselij, ki se od leta 
1980 do leta 2009, nekatera bolj, druga manj, širijo v svojo okolico. Hkrati s širjenjem 
naselij se povečuje število cest. Kmetijske površine se širijo ali krčijo v nasprotju s 
širjenjem ali krčenjem naseljenih, gozdnih in vodnih površin. Na sliki 51 in sliki 56 so 
prikazani deleži kategorij rabe tal, razen kategorije vode, ki v nobenem obdobju ne 
presega 1 % območja Goričkega ali Ravenskega. Deleži posameznih kategorij so bili 
izračunani z orodjem za prekrivanje slojev (razdelek 3.3). 
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Slika 51:  Delež kategorij rabe tal v letih 1850, 1890, 1940, 1971 in 2009 na Goričkem 

 
4.3.1 Goričko 
 
Na Goričkem se površine kmetijskih zemljišč zmanjšujejo (slika 51) vse od leta 1850 do 
leta 2009. Največji delež (59 %) kmetijskih zemljišč je bil leta 1850, najmanjši (53 %) 
pa leta 2009. Z gozdnimi in urbanimi površinami je prav nasprotno. Najmanjši (39 %) 
delež gozdnih površin je bil leta 1850, največji (42 %) pa od leta 1940 do leta 2009. 
Gozdne površine so se povečevale na račun zmanjševanja kmetijskih površin. Delež 
urbanih zemljišč se povečuje. Leta 1850 je bil najnižji (2 %) in leta 2009 najvišji (5 %). 
 
Po letu 1940 je na Goričkem že prisotno razraščanje gozda v kmetijske površine, iz 
česar lahko sklepam, da se opušča obdelovanje kmetijskih površin, kar tudi navajajo 
različni avtorji, na primer Deu Ž. (2001). Novogradnje se že leta 1890 pojavljajo izven 
obstoječih naselij, ob glavnih cestah, iz česar sklepam, da na Goričkem ni večjih 
obdelovalnih površin in zato ni treba tako kot na Ravenskem gledati na to, da si ne bi 
pozidali za poljedelstvo primernih površin. Dejstva, da se naselja na Goričkem začnejo 
prej pojavljati na novih površinah kot na Ravenskem, pa si ne smemo tolmačiti v 
smislu, da v okolici središča obstoječega naselja ni bilo možno graditi in so zato odšli 
na nove lokacije, ker se vsa naselja do leta 2009 širijo v svojo okolico. Na Goričkem je 
že leta 1890 opaziti razpršeno obcestno novogradnjo, od takrat dalje vse do leta 2009 
pa večanje naselij v svojo okolico in tudi nove razpršene gradnje ob glavnih cestah. Na 
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slika 52 je prikazana širitev naselja Prosečka Vas. Naselje je razloženo, večina stavb je 
ob glavnih cestah. Tudi nove stavbe se vse do leta 2009 pojavljajo ob glavnih cestah, 
nekaj pa tudi v okolici starejših delov naselij. Naselje je leta 1850 sestavljeno iz več 
ločenih delov, leta 2009 pa so ti deli še ločeni, vendar so razdalje med njimi manjše. 
Naselje je že leta 1850 na pobočju in na vznožju vzpetine. V letu 1890 je opazna 
sprememba cest, ob katerih se leta 1940 pojavi novogradnja. 

 

 
 

Slika 52:  Spremembe naselja (rdeča) Prosečka vas od leta 1850 do leta 2009 
 
Slika 53 prikazuje spremembo potoka Bezjak v bližini naselja Kovačevci. Od leta 1850 
do leta 1971 na potoku ni sprememb. Na sloju rabe tal leta 2009 oba pritoka izgineta. S 
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preverjanjem sloja rabe tal iz leta 2009 z DOF-om sem ugotovila, da je prišlo do 
spremembe struge potoka, vendar gre v tem primeru za napako na sloja rabe tal iz leta 
2009. Iz DOF-a je razvidno, da sta pritoka obraščena z drevjem, ki je na sloju rabe tal 
narisano namesto potoka. Spremembe desnega pritoka v letu 2009 so: nekoliko krajša 
struga v zgornjem delu in stoječi vodi. Glede na to, da je zgornja stoječa voda 
pravokotne oblike in stoji pred stavbo, sklepam, da gre za hišni bazen, ki nima 
nikakršne zveze s potokom, spodnja stoječa voda pa se nahaja tik ob strugi potoka in 
je možno, da je nekakšen ostanek zgornjega dela potoka. 
 

 
 

Slika 53:  Spremembe vodotoka (modra) Bezjak od leta 1850 do leta 2009 
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Slika 54 prikazuje izsekavanje gozda ob vasi Dolnji Slaveči. Največji izsek gozda je 
viden v obdobjih 1850–1890 in 1890–1940, s katerim so pridobili kmetijska zemljišča in 
prostor za zidavo. Leta 2009 pa je že opaziti večanje manjših gozdnih površin na 
kmetijskem zemljišču. Ozek zelen pas gozda, ki poteka po sredini spodnjih slik, je 
potok Lukaj, obraščen z drevjem. 
 

 
 
Slika 54: Sprememba gozdne površine (zelena) v Dolnjih Slavečih od leta 1850 do leta 

2009 
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Slika 55 prikazuje zaraščanje gozdnih površin severno od naselja Mačkovci. 
Zaraščanje poteka vse od leta 1850 do leta 2009 in je najopaznejše v obdobju 1850–
1980. 
 

 
 
Slika 55:  Sprememba gozdne površine (zelena) severno od Mačkovcev od leta 1850 

leta do 2009 
 
4.3.2 Ravensko 
 
Na Ravenskem se je delež kmetijskih površin povečal za 2 % v obdobju 1850–1890 in 
nato zmanjšal za 1 % (slika 56). Tako so kmetijska zemljišča zasedala najmanjši 
(76 %) odstotek Ravenskega leta 1850, največji leta 1890, od leta 1940 do leta 2009 
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pa je odstotek nespremenjen (77 %). Gozdne površine so bile najobsežnejše (20 %) 
leta 1850. V obdobju 1850–1940 so bile skrčene, od takrat dalje do leta 2009 pa je 
njihov delež (18 %) ostal nespremenjen. Delež urbanih površin se, tako kot na 
Goričkem, povečuje. Najmanjši (3 %) je bil leta 1850 in največji (5 %) leta 2009. 
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Slika 56:  Delež kategorij rabe tal v letih 1850, 1890, 1940, 1971 in 2009 na 
Ravenskem 

 
Iz ugotovljenih sprememb gozdne površine predvidevam, da se je gozd v obdobju 
1850–1890 na Ravenskem, kjer so poljske površine, še krčil z namenom pridobitve 
kmetijskih zemljišč. Ker je več kmetijskih obdelovalnih površin, se naselja najprej širijo 
okoli svojega središča, po letu 1980 pa se pojavijo novogradnje tik ob glavnih cestah. 
Vsa poseljena območja pa se do leta 2009 širijo okoli svojega središča v kmetijske 
površine, ki jih obdajajo. Kljub širjenju v kmetijska zemljišča se naselja na Ravenskem 
držijo glavnih cest. Na Ravenskem je izrazito spreminjanje vodotokov, saj se v obdobju 
1940–1971 pojavijo zravnane in preusmerjene struge, nekatere pa izginejo, kar je 
najverjetneje posledica melioracije, ki se je v Prekmurju izvajala v sedemdesetih in 
osemdesetih letih 19. stoletja. Izvedba melioracij, ki je bila izvedena z namenom 
osuševanja tal in pridobivanja kmetijskih zemljišč, ima za posledico izgubo vodnatosti 
potokov, zmanjšanje biodiverzitete voda ter okolice potočnih strug in padec ravni 
podtalnice (Hönigsfeld Adamič M., 2003). 
 
Naselji Gorica in Puconci sta bili do leta 1850 ločeni naselji. Vse do leta 2009 se naselji 
širita v svojo okolico (slika 57). Do leta 1940 se povečata do te mere, da postaneta 
povezani. S hitro rastjo naselij se pojavljajo tudi nove ceste. Naselji se širita najprej ob 
cestah do leta 1890, pozneje pa ob novih cestah, ki so bile zgrajene v obdobju 1890–
1940. 
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Slika 57:  Sprememba območij naselij (rdeča) Gorice in Puconcev v letih od 1850 do 
2009 

 
Slika 58 prikazuje potoke južno od naselja Predanovci. Na sliki iz leta 1850 je spodnji 
potok Ledava, zgornji pa je Brezovski potok in sredinski pritok Brezovskega potoka. Že 
v obdobjih 1850–1890 in 1890–1940 se pojavijo nove struge potokov, speljane iz 
pritoka Brezovškega potoka. V obdobju 1940–1971 je potek pritoka Brezovškega 
potoka povsem spremenjen: struga poteka južneje in je izravnana, kar priča o 
melioraciji tega potoka. V obdobju 1971–2009 ta pritok v celoti izgine. Glede na to, da 
je na sloju rabe tal iz leta 2009 več napak v zvezi z vodotoki, je možno, da je tudi na 
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tem mestu napaka. Spodnji primer spreminjanja vodotokov priča o spremembah načina 
kmetovanja, saj je za intenzivnejše kmetovanje pomembna prisotnost vode. Istočasno 
so za obdelovanje z moderno mehanizacijo zaželene čim večje strjene površine, kar je 
najverjetneje vzrok spremembi v obdobju 1940–1971 (Ogrin D., 2010). 
 

 
 

Slika 58:  Sprememba vodotokov (modra) Ledave, Brezovskega potoka in njegovega 
pritoka v Predanovcih od 1850 do 2009 

 
Na sliki 59 je prikazano krčenje gozda zahodno od naselja Markišavci. Krčenje je 
najbolj opazno v obdobju 1890–1940. Od leta 1940 do leta 2009 v obsegu gozdne 
površine ni opaznih sprememb. Iz slik je razvidno, da so gozd izkrčili za pridobitev 
novih kmetijskih površin. 
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Slika 59:  Krčenje gozdne (zelena) površine zahodno od Markišavcev od leta 1850 do 

leta 2009 
 
Gozdno površino južno od Brezovcev (slika 60) so v obdobju 1890–1940 skrčili in s 
tem pridobili nove kmetijske površine. V obdobju 1940–1971 je že prisotno zaraščanje 
kmetijskih površin. Za leto 1940 ni podatka za celotno območje, zato je slika za leto 
1940 ožja od preostalih. 
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Slika 60:  Krčenje gozdne (zelena) površine južno od Brezovcev od leta 1850 do leta 
2009 
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5 ZAKLJU ČKI 
 
Pri opredelitvi položaja naselij po prostorskih danostih sem iskala odgovore na 
vprašanja, značilna za geografske analize: ali se na določenem območju nahajajo 
naselja, kje se naselja nahajajo in kakšne so njihove spremembe v obdobjih: 1850–
1890, 1890–1940, 1940–1971 in 1971–2009. Na osnovi dobljenih rezultatov, ki so 
podani z odstotki in s prikazom na slikah (razdelek 4), sem ugotovila, katere prostorske 
dejavnike upoštevajo in katerih ne upoštevajo naselja iz leta 1850, ter v kolikšni meri te 
dejavnike upoštevajo novogradnje iz preostalih obravnavanih obdobij in kakšne so bile 
spremembe pokrajine tekom obravnavanih obdobij na testnem območju. 
 
Iz rezultata deduktivnega (razdelek 4.1.2) modela lahko zaključim, da novejše 
novogradnje čedalje manj upoštevajo enake prostorske značilnosti, kot naselja iz leta 
1850, kar je najbolj vidno na Ravenskem pri novogradnjah iz obdobja 1971–2009. 
Naselja iz leta 1850 se na Ravenskem ujemajo z Boolovo ploskvijo modela 76 %, 
novogradnje iz obdobja 1971–2009 pa 52 %. Na Goričkem je ta razkorak manjši: 
naselja iz leta 1850 se z Boolovo površino ujemajo 31 %, novogradnje iz obdobja 
1971–2009 pa 24 %. Ujemanje površin novogradenj z Boolovo površino skozi obdobja 
nekoliko niha, a se kljub temu opazi trend manjšanja ujemanja tekom obdobij. 
 
Podobno lahko zaključim iz rezultata induktivnega modela (razdelek 4.1.3), kjer se 
skozi obdobja prav tako kaže čedalje manjše upoštevanje prostorskih značilnosti, ki so 
jih upoštevala naselja iz leta 1850. Na Goričkem je ta trend lepo viden: z Boolovo 
površino modela se ujema 80 % naselij iz leta 1850, z novogradnjami iz obdobja 1971–
2009 pa 66 %. Na Ravenskem je tekom obdobij prisotno nihanje ujemanja deleža 
novogradenj z deležem ujemanja naselij iz leta 1850. Kljub temu je ujemanje 
novogradenj iz obdobja 1971–2009 manjše (76 %) od ujemanja naselij iz leta 1850 
(85 %) z Boolovo površino modela. 
 
Rezultati ugotavljanja leg naselij (razdelek 4.2) so povzeti v Tabela 3. Ugotovila sem, 
da je v vseh obdobjih največji delež naselij na zahodni, južni in vzhodni ekspoziciji 
površja, ter da se v obdobjih 1850–1890, 1890–1940 in 1940–1971 največ novogradenj 
pojavi na vzhodni oziroma jugovzhodni ekspoziciji. Glede na naklon površja leži največ 
naselij na Goričkem in Ravenskem v vseh obravnavanih obdobjih na naklonu do 
vključno 5°. Na Gori čkem je prisoten trend širjenja naselij na pobočja z večjimi nakloni, 
od leta 1890 do leta 2009 celo na naklone, večje od 15°. Ugotovila sem, da je delež 
naselij iz leta 1850, oddaljenih od vodotokov do vključno 200 m, skoraj enak na 
Goričkem (31 %) in na Ravenskem (33 %), ter da se na Goričkem z oddaljenostjo od 
vod zmanjšuje. Na Ravenskem je največ (46 %) naselij oddaljenih od vod za več kot 
500 m. Primerjanje leg naselij in novogradenj z območjem katastrofalnih poplav je 
pokazalo, da se naselja iz leta 1850 na Goričkem in Ravenskem izogibajo tem 
območjem, tekom obravnavanih obdobij pa se novogradnje pojavljajo tudi na poplavnih 
območjih. Leta 2009 je bilo na poplavnem območju na Goričkem 3 % novogradenj, na 
Ravenskem pa 1 %. Prav tako sem ugotovila, da se večina novogradenj na Goričkem 
(87– 92 %) in Ravenskem (88–94 %) v vseh obravnavanih obdobjih širi na kmetijska 
zemljišča. Glede na ukrivljenost površja se je izkazalo, da je več naselij iz leta 1850 in 
tudi novogradenj iz ostalih obravnavanih obdobij na konveksno ukrivljenem površju, 
vendar se ta delež tekom obdobij zmanjšuje, kot na konkavno ukrivljenem površju, kjer 
delež novogradenj tekom obdobij raste. Pri primerjanju leg naselij z območji, kjer je 
vetrovnost največja, se je pokazalo, da se niti naselja iz leta 1850 niti poznejše 
novogradnje ne izogibajo tem območjem, kar ni presenetljivo, saj hitrosti vetra na tem 
delu Slovenije po Beaufortovi lestvici sodijo med lahke sapice do šibkih vetrov. Prav 
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tako se tekom let povečuje odstotek novogradenj na najbolj vlažnih območjih, medtem 
ko leta 1850 naselja na Goričkem tam sploh niso prisotna, na Ravenskem pa so, 
vendar v manjši meri kot leta 2009. Na Goričkem je v obdobju 1971–2009 7 % 
novogradenj na najbolj vlažnih tleh, na Ravenskem pa 11 %. Večji odstotek na 
Ravenskem je pričakovan, saj so tam tla bolj vlažna kot na Goričkem. 
 

Tabela 3:  Matrična tabela rezultatov značilnosti leg naselij 
 

 
 

 
 

 
 



 69 

 
 

Rezultati ugotavljanja leg naselij (razdelek 4.2) so pokazali značilno drugačno lego 
novogradenj na testnem območju predvsem v obdobjih 1940–1971 in 1971–2009 glede 
na naselja iz leta 1850. Značilna drugačnost prvotnega stanja od končnega se 
ugotavlja s statističnimi testi značilnosti, vendar ti v nalogi niso bili izvedeni, zato 
značilno drugačnost končnega stanja od prvotnega povzemam kvalitativno iz dobljenih 
rezultatov obravnavanih parametrov. Odstopanja od naselij iz leta 1850 se kažejo tudi 
pri novogradnjah iz obdobij 1850–1890 in 1890–1940, vendar v manjši, neznačilni meri. 
 
Prav tako sem ugotovila spremembe rabe tal (razdelek 4.3) v obdobjih od leta 1850 do 
leta 2009. Na Goričkem je tekom obravnavanih obdobij prisoten trend manjšanja 
kmetijskih zemljišč (59–53 %) in večanje gozdnih (39–42 %) ter urbanih površin (2–5 
%). Za Goričko je značilen trend padanja deleža kmetijskih in urbanih površin, ter 
nespremenjen delež gozdnih površin v obdobjih 1850–1890 in obdobjih od leta 1890 
do leta 2009. Na Ravenskem je vidno večanje kmetijskih površin z rahlim odstopanjem 
v obdobju 1850–1890 (78 %), manjšanjem gozdnih površin (20–18 %) in večanjem 
urbanih površin (2–5 %). Za Ravensko je prav tako značilen trend rasti deleža urbanih 
površin ter nespremenjen delež kmetijskih in gozdnih površin v vseh obdobjih od leta 
1850 do leta 2009. 
 
Analize stanja (lege naselij in raba tal) v preteklosti temeljijo na historičnih kartah, za 
katere je značilna slabša kakovost in izdelava v manjših merilih. Poleg tega so bile za 
analize uporabljene historične karte različnih meril. Slabša kakovost kart vpliva na 
kakovost izdelanih podatkovnih slojev, zaradi česar so pri interpretaciji možne napake. 
 
Hipoteze sem potrdila z izračunom verjetnosti uspešnih primerov in testom deleža. 
Ugotovila sem, da je ob predpostavki normalne porazdelitve in v primerjavi verjetnosti 
lege naselij pri normalni porazdelitvi večja verjetnost naselij iz leta 1850 na območjih 
ekspozicije od zahoda do vzhoda, na pobočjih z nakloni do 5°, na oddaljenosti do 
500 m od vodotokov na Goričkem in novogradenj iz obdobja 1971–2009 na kmetijskih 
zemljiščih, in manjša verjetnost za lego naselij na zavetrnih legah in oddaljenostjo od 
vodotokov manj od 500 m na Ravenskem. 
 
Prva hipoteza je sestavljena iz več delov in trdi, da so naselja iz leta 1850 na Goričkem 
postavljena na sončnih legah, zavetrnih legah in pobočjih z manjšim naklonom. 
Hipotezo sprejmem, saj drži, da naselja ležijo na sončnih legah, položnejših pobočjih in 
zavetrnih legah. Pri analizah leg naselij sem ugotovila, da leži 64 % naselij iz leta 1850 
na Goričkem na ekspozicijah od zahoda do vzhoda, da leži 57 % naselij iz leta 1850 na 
Goričkem in 100 % naselij iz leta 1850 na Ravenskem na pobočjih z naklonom do 
vključno 5°, ter da leži 71 % naselij iz leta 1850 na Gor ičkem na zavetrnih legah. 
 
Naslednja hipoteza trdi, da so naselja iz leta 1850 oddaljena od vodotokov manj kot 
500 m. Tudi to hipotezo delno potrdim, saj drži le na območju Goričkega in ne tudi na 
območju Ravenskega. Pri analizah leg naselij iz leta 1850 sem ugotovila, da je 81 % 
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naselij na Goričkem oddaljenih od vod do vključno 500 m, na Ravenskem pa je takšnih 
naselij 54 %. 
 
Zadnja hipoteza trdi, da se naselja širijo na kmetijska zemljišča. Hipotezo potrdim, saj 
drži za novogradnje iz obdobja 1971–2009 na Goričkem in Ravenskem. Pri analizah 
sem ugotovila, da je bilo v obdobju 1971–2009 na Goričkem 91 % in na Ravenskem 
88 % novogradenj zgrajenih na kmetijskih zemljiščih. 
 
Analize leg naselij na testnem območju so predvsem v 20. stoletju pokazale širitev 
naselij na kmetijske površine in druga neprimerna območja, na primer območje 
katastrofalnih poplav. Pri umeščanju objektov v prostor bi se morali kmetijskim 
zemljiščem in območjem z neprimernimi lastnostmi za gradnjo v čim večji meri izogniti, 
pri iskanju novih območij pa upoštevati alternativne rešitve in nujnost pozidave. 
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PRILOGA A: Delitev naravnih danosti okolja 
 

Nosilnost 
površja

Stabilnost tal

Tektonski 
pojavi

Razgibanost 
površja

Oblikovanost 
površja

Nagib površja

Tla

Voda

Zrak

Naravne 
danosti

Hrup

Onesnaženje 
zraka

Veter

Osončenje

Podnebje

 Varstvo 
naravne 

dediščine

Vegetacijski 
pokrov

Rodovitnost tal

Kameninska 
sestava

Geomorfološke 
danosti

Nadmorska 
višina

 



 

PRILOGA B: Delitev ustvarjenih danosti 
 

Ustvarjene 
danosti 

Demografija

Urbana raba 
tal

Naselitvena 
raba prostora

Območja delovnih 
mest v proizvodnji

Centralne 
dejavnosti

Mestni centri

Otroško varstvo in 
šolstvo

Zdravstvo in 
socialno varstvo

Trgovina

Gostinstvo

Turizem, zabava, 
šport, rekreacija

Kultura in 
umetnost

Poslovne in 
denarne 

dejavnosti

Javna uprava, 
policija, sodstvo

Zelene 
površine

Infrastrukturni 
objekti in 
naprave

Promet in 
zveze

Energetika

Komunalne 
dejavnosti

Območja za 
posebne 
namene

Varstvo 
kulturne 

dediščine
Informacije

 
 
 



 

PRILOGA C: Seznam uporabljenih ukazov v ArcGIS-u in  SAGA GIS-u 
 
Ukaz v angleš čini Slovensko Opis ukaza 

Aspect ekspozicija 
iz rastrskega sloja površja  
izdela sloj ekspozicije 

BooleanAnd Boolov operator AND 

združi dva binarna rastrska 
sloja po principu, če sta  
rastrski celici pravilni, operator 
vrne pravilno 

BooleanOR Boolov operator XOR 

združi dva binarna rastrska 
sloja po principu, če je ena ali 
druga rastrska celica, operator 
vrne pravilno 

Buffer območje oddaljenosti 
iz vektorskega sloja izdela sloj 
oddaljenosti od točke, linije ali 
poligona 

Clip izrez 
izreže vektorski ali rastrski sloj 
na območje izbrane oblike 

Combine iskanje kombinacij 

združuje rastrske sloje z več 
vrednostmi po načelu  
dodeljevanja novih vrednosti 
vsem kombinacijam vrednosti 
vhodnih rastrov 

Contour plastnice 
iz rastrskega sloja površja 
izdela vektorski linijski sloj 
plastnic 

Create New Feature ustvari nov vektorski  
objekt 

ustvari nov prazen vektorski 
sloj, kamor vnašamo točkovne, 
linijske ali poligonske objekte 

Curvature ukrivljenost 
iz rastrskega sloja površja 
izdela sloj ukrivljenosti  
površja 

Cut Polygon Feature odreži vektorski objekt 
odreže del označenega 
poligonski vektorskega objekta 

Dissolve razvezava območij 
združuje sosednje vektorske 
objekte z enakimi vrednostmi 

Feature Dataset nabor poligonskih  
podatkov 

ustvari se mapa, v katero se 
shranjujejo poligonski  
podatkovni sloji 

Gaussian Filter Gaussov filter 
zgladi (zmanjša) razlike med 
sosednjimi  
rastrskimi celicami 

Greater Than Equal več ali enako 

operator vrne za pravilno 
vrednosti rastrskega sloja, ki so 
večje ali enake od določene 
vrednosti 

 
se nadaljuje 



 

 
 
 

nadaljevanje 
 
Angleško Slovensko Opis ukaza 

Hillshade senčenje 
iz rastrskega sloja površja  
izdela sloj senc 

Import Coverage 
uvozi prekrivni podatkovni 
sloj 

na želeno mesto uvozi 
prekrivni podatkovni sloj 

Less Than Equal  manj kot ali enako 

operator vrne za pravilno 
vrednosti rastrskega sloja, ki so 
manjše ali enake od določene 
vrednosti 

Measure meter izmeri razdaljo 

Merge združitev slojev 

dva poligonska sloja združi s 
postavitvijo enega poleg 
drugega 

polygon To Raster poligon v raster 

pretvorba poligonskega 
vektorskega sloja v rastrski 
 sloj 

Raster Calculator rastrski računalnik 
orodje za poganjanje  
algebrskih izrazov 

Reclassify ponovna klasifikacija 

vrednostim rastrskega sloja 
zamenja z novimi  
vrednostmi 

Save Edits shrani popravke 

shrani popravke, ki so bili 
narejeni na objektih  
poligona 

Select by attributes izberi po atributih 

izbere točkovne, linijske ali 
poligonske sloje glede na 
njihovo vrednost v atributni 
tabeli 

Slope naklon 
iz rastrskega sloja površja  
izdela sloj naklonov 

Stop Editing prenehaj s popravljanjem 
ugasne orodje za popravljanje  
poligonskih slojev 

Update prekrivanje 

vektorski sloj prekrije z drugim 
vektorskim slojem tako, da 
privzame spodnji sloj vrednosti 
zgornjega sloja 

Validate Entire Topology 
preveri topologijo na  
celotnem območju 

preveri pravila določena s 
topologijo in prikaže napake, ki 
tem pravilom ne ustrezajo 

Wind Effect vetrovnost 
iz rastrskega sloja površja  
izdela sloj vetrovnosti 



 

 
PRILOGA Č: Seznam osnovnih uporabljenih podatkovnih slojev 
 

Ime Tip Leto Merilo Vir 
Ceste (GKB 25) vektor 2000 1 : 25.000 GURS 
Digitalni model reliefa 
(DMR) raster  2005 12,5 m GURS 

Gospodarska javna 
infrastruktura 
(GJI) vektor 2004–2010 1 : 500–1 : 25.000 GURS 

Opozorilna karta poplav vektor 2007 1 : 50.000 

spletna stran 
podjetja 
DHD 
d. o. o. 

Raba tal vektor 2009 1: 5000 MKGP 
 



 

PRILOGA D: Podatkovni sloji, pridobljeni iz DMR-ja 
 

 
 

 



 

PRILOGA E: Seznam podatkovnih slojev, uporabljenih za izdelavo slojev rabe tal 
 

Ime Leto Merilo Vloga 

Primernost 
sekundarnih  
kart Vir 

digitalni ortofoto 
(DOF)  2006 1 : 5000 sekundarna zelo dobra GURS 

karta vojaške 
geografske 
izmere (VGI) 1971 1 : 25.000 primarna / 

doc. dr. 
Tomaž 
Podobnikar 

karta 
Lendavskih 
goric 1967 1 : 50.000 sekundarna dobra 

doc. dr. 
Tomaž 
Podobnikar 

Jugoslovanska 
topografska 
karta (TK) 1940 1 : 25.000 primarna / 

doc. dr. 
Tomaž 
Podobnikar 

Hydrologische 
karte der 
Umgebung von 
Laibach 1948 1 : 25.000 sekundarna dobra 

doc. dr. 
Tomaž 
Podobnikar 

karta Prekmurje 1955 1 : 25.000 sekundarna dobra 

doc. dr. 
Tomaž 
Podobnikar 

karta Lendava 1950 1 : 50.000 sekundarna dobra 

doc. dr. 
Tomaž 
Podobnikar 

karta 3. vojaške 
izmere 1980 1 : 75.000 primarna / 

doc. dr. 
Tomaž 
Podobnikar 

Radkersburg 
und 
Luttenberg 1894 1 : 75.000 sekundarna slaba 

doc. dr. 
Tomaž 
Podobnikar 

Steinmark Nord-
Kroatien 
und West-
Ungarn 1925 1 : 400.000 sekundarna zelo slaba 

doc. dr. 
Tomaž 
Podobnikar 

karta 2. vojaške 
izmere 1850 1 : 28.800 primarna / 

doc. dr. 
Tomaž 
Podobnikar 

Karte des 
Kronlandes  
Steiermark  1855 1 : 400.000 sekundarna zelo slaba 

doc. dr. 
Tomaž 
Podobnikar 

General Post 
und Strassen 
Karte des 
Herzogthums 
Steyermark 1841 1 : 400.000 sekundarna zelo slaba 

doc. dr. 
Tomaž 
Podobnikar 

 



 

PRILOGA F: Prvotne in spremenjene kategorije rabe t al 2009 
 

Kategorija  

Prvotna kategorija Spremenjena kategorija 

Raba tal 
ID 
rabe 
tal 

Raba tal (2) 

Raba tal 
(3) 
(v atributni 
tabeli) 

ID 
rabe 
tal 

Barva 
na 
sloju 
rabe tal  

Njiva 1100 

Trajne rastline na njivskih 
površinah 

1180 

Rastlinjak 1190 

Njive in vrtovi 

Vinograd 1211 

Intenzivni sadovnjak 1221 
Ekstenzivni oziroma 
travniški 
sadovnjak 

1222 

Ostali trajni nasadi 1240 

Trajni nasadi 

  

Trajni travnik 1300   

Kmetijsko zemljišče poraslo 
z gozdnim drevjem 

1800 
Travniške 
površine 

Kmetijsko zemljišče v 
zaraščanju 1410 

Neobdelano kmetijsko 
zemljišče 

1600 

Druge 
kmetijske 
površine 

Barje 4100 

Trstičje 4210 

Ostalo zamočvirjeno 
zemljišče 

4220 

Ostala 
nekmetijska 
zemljišča 

Kmetijska 
zemljišča 1 

  

Gozd 2000   
Drevesa in grmičevje 1500   

Plantaža gozdnega drevja 1420 
Gozd Gozd 2 

  
Naselja   
Ceste   

Železnice 

3000 
Pozidano in 
sorodno 
zemljišče 

Urbano 
zemljišče 4 

  
Reke   
Potoki   

Jezera 

7000 Voda Vode 5 

  
 



 

PRILOGA G: Prikaz programskega vmesnika orodja za r ačunanje kapa-testa 
neodvisnosti v ArcGIS-u 
 

 



 

PRILOGA H: Skripta orodja kapa-testa neodvisnosti v  ArcGIS-u 
 
#referenciranje ustreznih knjižnic 
import arcgisscripting, sys, os, string, math 
 
#kreiranje objekta geoprocesor 
gp = arcgisscripting.create(9.3) 
gp.OverWriteOutput = 1 
 
#branje vhodnih parametrov 
filename = sys.argv[1] 
onlyfirst = sys.argv[2] 
onlysecond = sys.argv[3] 
both = sys.argv[4] 
none = sys.argv[5] 
 
#postavitev iskalnega kurzorja za branje atributne tabele 
rows = gp.SearchCursor(filename) 
 
#iskanje prvega zapisa v atributni tabeli 
row = rows.Next() 
 
#postavitev začetnih vrednosti 
onlyfirstvalue = 0 
onlysecondvalue = 0 
bothvalue = 0 
nonevalue = 0 
 
#zanka za branje vseh zapisov atributne tabele 
  cells = row.GetValue("COUNT") 
  parameter = row.GetValue("VALUE") 
  row = rows.Next() 
 
  if str(parameter) == onlyfirst: 
    onlyfirstvalue = float(cells) 
  if str(parameter) == onlysecond: 
    onlysecondvalue = float(cells) 
  if str(parameter) == both: 
    bothvalue = float(cells) 
  if str(parameter) == none: 
    nonevalue = float(cells) 
 
#izračuni 
a = bothvalue + onlysecondvalue 
b = onlyfirstvalue + nonevalue 
c = bothvalue + onlyfirstvalue 
d = onlysecondvalue + nonevalue 
e = a + b 
P1 = (bothvalue + nonevalue) / e 
P2 = a / e 
P3 = b / e 
P4 = c / e 
P5 = d / e 
P6 = P2 * P4 
P7 = P3 * P5 
P8 = P6 + P7 
 
K = ((P1 - P8) / (1 - P8)) * 100 
 
#izpis rezultata 
gp.addmessage ("Kappa value = " + str(K))  
 
 



 

PRILOGA I: Skripta orodja za izra čun prekrivanja slojev v ArcGIS-u 
 
#referenciranje ustreznih knjižnic 
import arcgisscripting, sys, os, string, math 
 
# kreiranje objekta geoprocesor 
gp = arcgisscripting.create(9.3) 
gp.OverWriteOutput = 1 
 
# branje vhodnih parametrov 
filename = sys.argv[1] 
onlyfirst = sys.argv[2] 
onlysecond = sys.argv[3] 
both = sys.argv[4] 
none = sys.argv[5] 
 
# postavitev iskalnega kurzorja za branje atributne tabele 
rows = gp.SearchCursor(filename) 
 
# iskanje prvega zapisa v atributni tabeli 
row = rows.Next() 
 
# postavitev začetnih vrednosti 
onlyfirstvalue = 0 
onlysecondvalue = 0 
bothvalue = 0 
nonevalue = 0 
 
# zanka za branje vseh zapisov atributne tabele 
  cells = row.GetValue("COUNT") 
  parameter = row.GetValue("VALUE") 
  row = rows.Next() 
 
  if str(parameter) == onlyfirst: 
    onlyfirstvalue = float(cells) 
  if str(parameter) == onlysecond: 
    onlysecondvalue = float(cells) 
  if str(parameter) == both: 
    bothvalue = float(cells) 
  if str(parameter) == none: 
    nonevalue = float(cells) 
# izračuni 
a = bothvalue + onlysecondvalue 
b = onlyfirstvalue + nonevalue 
c = bothvalue + onlyfirstvalue 
d = onlysecondvalue + nonevalue 
e = a + b 
 
POF = ( bothvalue / a ) * 100 
 
#izpis rezultata 
gp.addmessage ("Percent of settlement = " + str(POF))  



 

PRILOGA J: Model induktivnega in deduktivnega model a za Gori čko v ArcGIS-u 
 

 



 

 
PRILOGA K: Skripta orodja za iskanje obmo čij v ArcGIS-u 
 
# referenciranje ustreznih knjižnic 
import arcgisscripting, sys, os, string, math, arcpy 
from arcpy import env 
from arcpy.sa import * 
 
#kreiranje objekta geoprocesor 
gp = arcgisscripting.create(10.0) 
gp.OverWriteOutput = 1 
 
#inicializacija spremenljivk 
filename = [] 
column = [] 
minvalue = [] 
maxvalue = [] 
 
#branje vhodnih parametrov 
for i in range(0,10): 
 filename.append(sys.argv[1 + i*4]) 
 column.append(sys.argv[2 + i*4]) 
 minvalue.append(sys.argv[3 + i*4]) 
 maxvalue.append(sys.argv[4 + i*4]) 
outrstname = sys.argv[41] 
 
rast = [] 
for i in range(0,10): 
 if (filename[i] != "#"): 
  if (column[i] != "#") and (minvalue[i] != "#") and (maxvalue[i] != "#"): 
   minvalue[i] = float(minvalue[i]) 
   maxvalue[i] = float(maxvalue[i]) 
      
   # postavitev iskalnega kurzorja za branje atributne tabele 
   rows = gp.SearchCursor(filename[i]) 
 
   #iskanje prvega zapisa v atributni tabeli 
   row = rows.Next() 
    
   # zanka za branje vseh zapisov atributne tabele 
   j = 0    
   rmp = RemapValue([]) 
    
   while row: 
    j = j + 1;  
    val = float(row.GetValue(column[i])) 
    if (val >= minvalue[i]) and (val <= maxvalue[i]): 
     rmp.remapTable.append([val,1]) 
    else: 
     rmp.remapTable.append([val,0]) 
    row = rows.Next() 
     
   rast.append(Reclassify(filename[i],column[i],rmp)) 
    
  else: 
   rast.append(Raster(filename[i])) 
 
for i in range(0,len(rast)): 
 if (i > 0): 
  rast[i] = BooleanAnd(rast[i - 1],rast[i]) 
 
rast[i].save(str(outrstname)) 
 



 

PRILOGA L: Prikaz programskega vmesnika orodja za i skanje obmo čij v ArcGIS-
u 
 

 
 
… 
 

 
 



 

PRILOGA M: Rezultati izra čuna kapa-testa prekrivanja vhodnih podatkovnih 
slojev v modelih  
 

    Podatkovni sloj 1 Podatkovni sloj 2 Rezultat kapa-testa (%) 
naklon površja 2,5 
vlažnost tal -3,5 
vetrovnost 6,1 
naselja 2009 0,7 ekspozicija 

površja rezultat modela 2,5 

vlažnost tal -9,8 
vetrovnost 3,2 

naklon površja naselja 2009 -0,8 
vetrovnost –11,7 
naselja 2009 0 

vlažnost tal rezultat modela 0,13 
naselja 2009 –0,1 

vetrovnost rezultat modela 0,6 

G
or

ič
ko

 

rezultat modela naselja 2009 44,4 

  

vlažnost tal 0 

vetrovnost –0,2 
naselja 2009 0 

naklon površja rezultat modela 0 
vetrovnost –0,2 
naselja 2009 7,5 

vlažnost tal rezultat modela 9,7 
naselja 2009 0 

vetrovnost rezultat modela 0 

D
ed

uk
tiv

ni
 m

od
el

 

R
av

en
sk

o 

rezultat modela naselja 2009 84,8 
  
  

se nadaljuje 



 

nadaljevanje 
 

  Podatkovni sloj 1 Podatkovni sloj 2 Rezultat kapa-testa (%) 
naklon površja 3,4 
vlažnost tal 1,9 
vetrovnost 0,2 
naselja 2009 0,2 ekspozicija 

površja rezultat modela 0,1 
vlažnost tal –5,7 

vetrovnost –10,7 
naklon površja naselja 2009 2,5 

vetrovnost –5,6 
naselja 2009 0,3 

vlažnost tal rezultat modela 0,1 
naselja 2009 0,4 

vetrovnost rezultat modela –2,3 

G
or

ič
ko

 

rezultat modela naselja 2009 54,4 

  

vlažnost tal –3,7 
vetrovnost 10,6 
naselja 2009 –0,2 

naklon površja rezultat modela 0,2 
vetrovnost –11,7 
naselja 2009 –8,7 

vlažnost tal rezultat modela 0,1 

naselja 2009 –0,1 
vetrovnost rezultat modela 0,3 

In
du

kt
iv

ni
 m

od
el

 

R
av

en
sk

o 

rezultat modela naselja 2009 1,4 
 



 

PPRILOGA N: Seznam središ čnih koordinat prikazanih obmo čij na slikah 
 

Slika 

Približna središčna 
koordinata slike 

(v Gauss-Krügerjevem 
sistemu) 

Številka Opomba y x 
4 / 585008 178532 
5 / 593700 171800 
6 / 585008 178532 
7 / 585008 178532 
8 / 585008 178532 
9 / 585008 178532 

10 / 585008 178532 
11 leva in desna 585008 178532 
12 / 585008 178532 
13 / 585008 178532 
14 / 585008 178532 
15 / 585008 178532 
16 leva in desna 585008 178532 
17 leva in desna 581800 183000 
18 / 585008 178532 
19 / 585294 173053 
20 / 585228 180864 
21 / 585294 173053 
32 leva 582959 178595 
32 desna 583588 184307 
34 leva 588314 173777 
34 desna 586290 174214 
36 leva 587454 176406 
36 desna 582989 184747 
38 leva 586812 182247 
38 desna 588999 178995 
39 leva 581962 174619 
39 desna 589181 171987 
41 leva in desna 582348 181752 
42 leva 587736 172551 
42 desna 583052 174714 

 
se nadaljuje 

 
 
 
 
 



 

nadaljevanje 
 

Slika 

Približna središčna 
koordinata slike 

(v Gauss-Krügerjevem 
sistemu) 

Številka Opomba y x 

44 leva 587891 179008 
44 desna 583328 176252 
45 leva 584533 172275 
45 desna 586993 172172 
47 leva 586654 177473 
47 desna 587215 182064 
49 leva 582700 177400 
49 desna 582882 182543 
50 leva 584789 174137 
50 desna 582938 171874 
52 vse 587800 183000 
53 vse 587502 183234 
54 vse 582600 183000 
55 vse 588364 184437 
56 vse 588447 184550 
57 vse 588604 173752 
58 vse 588908 172391 
59 vse 588700 184437 
60 vse 585464 173110 

 



 

PRILOGA O: Seznam in razlaga uporabljenih pojmov 
 
Slovensko Angleško Opis pojma 

atributna tabela attribute table 

tabela, v kateri so prostorski ali neprostorski 
podatki združeni s posameznimi prikazanimi 
objekti (točkami, linijami, poligoni ali rastrskimi 
celicami) 

coverage 
podatkovni sloj coverage 

oblika zapisa vektorskega podatkovnega sloja, 
oblika zapisa uporabna v ArcInfu 

digitalni ortofoto 
digital 
orthophoto 

fotografija zemeljskega površja v digitalnem 
zapisu, ki je geometrično popravljena z uporabo 
kontrolnih točk 

dolina valley 
oblika zemeljskega površja, običajno ob vodnem 
toku 

karta, zemljevid map, chart 
pomanjšan in posplošen prikaz zemeljskega 
površja, natisnjen na papirju ali v digitalni obliki 

kulturna krajina landscape 
območje, omejeno s pogledom, ki ga je s svojo 
dejavnostjo sčasoma preoblikoval človek 

objekt object 
sestavni del podatkovnega sloja, poznan v treh 
oblikah: točkovni, linijski in poligonski 

osebna 
geozbirka 

personal 
geodatabase 

datoteka s končnico .mdb in omejeno velikostjo, v 
kateri so shranjeni podatkovni sloji in pripadajoče 
tabele z metapodatki 

parameter parameter  v nalogi gre za podatkovni sloj vključen v model 

Pyhton Pyhton programski jezik podprt v ArcMapu 
plastnica, 
izohipsa 

contour line, 
isoline linije, ki povezujejo točke z isto nadmorsko višino 

podatkovni sloj, 
sloj 

thematic layer, 
layer, coverage 

sloj v GIS-u, ki združuje objekte iste vrste ali 
tematike 

pokrajina province 
Območje z geografsko definiranimi mejami, ki 
združuje podobne morfološke oblike površja 

površje surface 

v nalogi gre za prikaz oblike vrhnjega dela Zemlje, 
v GIS-ih se izraz uporablja tudi za druge (zvezne) 
ploskve 

(re)klasifikacija, 
spreminjanje 
razredov, 
agregacija 

(re)classification, 
aggregation 

spreminjanje opisnih in/ali oblikovnih lastnosti 
objektov  

prekrivanje overlay 
polaganje slojev z istimi koordinatami enega čez 
drugega 

programski 
vmesnik 

graphical user 
interface 

uporabniški vmesnik, ki omogoča uporabniku 
upravljanje s programskim paketom 

rastrski sloj raster 

podatkovni sloj s prostorskimi podatki 
razporejenimi v mrežo, kjer je podatek definiran s 
položajem kvadratka v mreži 

 
se nadaljuje 



 

 
 
 
 
nadaljevanje 
 
Slovensko Angleško Opis pojma 
senčenje površja hill shading prikaz plastičnosti površja z uporabo senc 

shapefile 
podatkovni sloj shapefile 

oblika zapisa vektorskega podatkovnega sloja, 
sestavljeni iz vsaj treh datotek s končnicami: 
.shp, .shx in .dbf 

sleme, greben ridge enakomerno visok, podolgovat vrh vzpetine 

urbanizacija urbanization 
proces spreminjanja krajine tako, da ima 
spremenjeno lastnosti mesta 

vektorski sloj vector 

podatkovni sloj, zapisan v obliki črt, linij ali 
poligonov, kjer je vsaka točka definirana s 
koordinatnim parom 

 
 


